
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

iVMS-4200 Client Software 

 

 

 

 

 

 

 

 

 

 

 

 

User Manual 
UD.6L0202D1939A01  



User Manual of iVMS-4200 

1 
 

User Manual 

COPYRIGHT © 2015 Hangzhou Hikvision Digital Technology Co., Ltd.  

ALL RIGHTS RESERVED. 

Any and all information, including, among others, wordings, pictures, graphs are the properties 

of Hangzhou Hikvision Digital Technology Co., Ltd. or its subsidiaries (hereinafter referred to be 

“Hikvision”). This user manual (hereinafter referred to be “the Manual”) cannot be reproduced, 

changed, translated, or distributed, partially or wholly, by any means, without the prior written 

permission of Hikvision. Unless otherwise stipulated, Hikvision does not make any warranties, 

guarantees or representations, express or implied, regarding to the Manual. 

About this Manual 

This Manual is applicable to iVMS-4200 Client Software. 

The Manual includes instructions for using and managing the product. Pictures, charts, images 

and all other information hereinafter are for description and explanation only. The information 

contained in the Manual is subject to change, without notice, due to firmware updates or other 

reasons. Please find the latest version in the company website 

(http://overseas.hikvision.com/en/).  

Please use this user manual under the guidance of professionals. 

Trademarks Acknowledgement 

and other Hikvision’s trademarks and logos are the properties of Hikvision in 

various jurisdictions. Other trademarks and logos mentioned below are the properties of their 

respective owners. 

Legal Disclaimer 

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE PRODUCT DESCRIBED, WITH 

ITS HARDWARE, SOFTWARE AND FIRMWARE, IS PROVIDED “AS IS”, WITH ALL FAULTS AND 

ERRORS, AND HIKVISION MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT 

LIMITATION, MERCHANTABILITY, SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR PURPOSE, 

AND NON-INFRINGEMENT OF THIRD PARTY. IN NO EVENT WILL HIKVISION, ITS DIRECTORS, 

OFFICERS, EMPLOYEES, OR AGENTS BE LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL, 

http://overseas.hikvision.com/en/
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INCIDENTAL, OR INDIRECT DAMAGES, INCLUDING, AMONG OTHERS, DAMAGES FOR LOSS OF 

BUSINESS PROFITS, BUSINESS INTERRUPTION, OR LOSS OF DATA OR DOCUMENTATION, IN 

CONNECTION WITH THE USE OF THIS PRODUCT, EVEN IF HIKVISION HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. 

REGARDING TO THE PRODUCT WITH INTERNET ACCESS, THE USE OF PRODUCT SHALL BE WHOLLY 

AT YOUR OWN RISKS. HIKVISION SHALL NOT TAKE ANY RESPONSIBILITES FOR ABNORMAL 

OPERATION, PRIVACY LEAKAGE OR OTHER DAMAGES RESULTING FROM CYBER ATTACK, HACKER 

ATTACK, VIRUS INSPECTION, OR OTHER INTERNET SECURITY RISKS; HOWEVER, HIKVISION WILL 

PROVIDE TIMELY TECHNICAL SUPPORT IF REQUIRED.  

SURVEILLANCE LAWS VARY BY JURISDICTION. PLEASE CHECK ALL RELEVANT LAWS IN YOUR 

JURISDICTION BEFORE USING THIS PRODUCT IN ORDER TO ENSURE THAT YOUR USE CONFORMS 

THE APPLICABLE LAW. HIKVISION SHALL NOT BE LIABLE IN THE EVENT THAT THIS PRODUCT IS 

USED WITH ILLEGITIMATE PURPOSES.  

IN THE EVENT OF ANY CONFLICTS BETWEEN THIS MANUAL AND THE APPLICABLE LAW, THE 

LATER PREVAILS.  
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Chapter 1  Overview 

1.1 Description 

iVMS-4200 is a versatile video management software for the DVRs, NVRs, IP cameras, encoders, 

decoders, VCA device, alarm host, etc. It provides multiple functionalities, including real-time live view, 

video recording, remote search and playback, file backup, alarm receiving, etc., for the connected 

devices to meet the needs of monitoring task. With the flexible distributed structure and easy-to-use 

operations, the client software is widely applied to the surveillance projects of medium or small scale. 

This user manual describes the function, configuration and operation steps of iVMS-4200 software. To 

ensure the properness of usage and stability of the software, please refer to the contents below and 

read the manual carefully before installation and operation. 

1.2 Running Environment 

Operating System: Microsoft Windows XP /Windows 2003 (32-bit), Windows 7 / Windows 8 / 

Windows 8.1 / Windows Server 2008 (32-bit or 64-bit), Windows Server 2008 R2 / Windows Server 

2012 (64-bit) 

CPU: Intel Pentium IV 3.0 GHz or above 

Memory: 1G or above 

Video Card: RADEON X700 Series or above 

GPU: 256 MB or above 

Notes: 

 For high stability and good performance, these above system requirements must be met.  

 The software does not support 64-bit operating system; the above mentioned 64-bit operating 

system refers to the system which supports 32-bit applications as well. 

1.3 Function Modules 

Control Panel of iVMS-4200: 
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Menu Bar: 

File 

Open Captured picture Search and view the captured pictures stored on local PC.  

Open Video File Search and view the video files recorded on local PC. 

Open Log File View the backup log files. 

Exit Exit the iVMS-4200 client software. 

System 

Lock Lock screen operations. Log in the client again to unlock. 

Switch User Switch the login user. 

Import System Config File Import client configuration file from your computer. 

Export System Config File Export client configuration file to your computer. 

View 

1024*768 Display the window at size of 1024*768 pixels. 

1280*1024 Display the window at size of 1280*1024 pixels. 

1440*900 Display the window at size of 1440*900 pixels. 

1680*1050 Display the window at size of 1680*1050 pixels. 

Maximize Display the window in maximum mode. 

Control Panel Enter Control Panel interface. 

Main View Open Main View page. 

Remote Playback Open Remote Playback page. 

E-map Open E-map page. 

Auxiliary Screen Preview Open Auxiliary Screen Preview window. 

Tool 

Device Management Open the Device Management page. 

Event Management Open the Event Management page. 

Storage Schedule Open the Storage Schedule page. 

Account Management Open the Account Management page. 

Log Search Open the Log Search page. 

System Configuration Open the System Configuration page. 
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Broadcast Select camera to start broadcasting. 

Device Arming Control Set the arming status of devices. 

I/O Control Turn on/off the alarm output. 

Batch Wiper Control Batch starting or stopping the wipers of the devices. 

Batch Time Sync Batch time synchronization of the devices. 

Player Open the player to play the video files. 

Message Queue Display the information of Email message to be sent. 

Help 

Open Wizard Open the guide for the client configuration. 

Open Video Wall Wizard Open the guide for the video wall configuration. 

User Manual (F1) 
Click to open the User Manual; you can also open the User 

Manual by pressing F1 on your keyboard. 

About View the basic information of the client software. 

Language 
Select the language for the client software and reboot the 

software to activate the settings. 

Note: The Open Video Wall Wizard item only displays when Decoding Device is enabled for adding to 

the client. For details, please refer to Chapter 12 Decoding and Displaying Video on Video Wall. 

 

The iVMS-4200 client software is composed of the following function modules: 

 

The Main View module provides live view of network cameras and video encoders, and 

supports some basic operations, such as picture capturing, recording, PTZ control, etc. 

 
The Remote Playback module provides the search, playback, export of record files. 

 

The Video Wall module provides the management of decoding device and video wall and 

the function of displaying the decoded video on video wall. 

 

The E-map module provides the displaying and management of E-maps, alarm inputs, hot 

regions and hot spots. 

 

The Device Management module provides the adding, modifying and deleting of different 

devices and the devices can be imported into groups for management. 

 

The Event Management module provides the settings of arming schedule, alarm linkage 

actions and other parameters for different events. 

 The Storage Schedule module provides the schedule settings for recording and pictures. 

 

The Account Management module provides the adding, modifying and deleting of user 

accounts and different permissions can be assigned for different users. 

 

The Log Search module provides the query of system log files and the log files can be 

filtered by different types. 

 

The System Configuration module provides the configuration of general parameters, file 

saving paths, alarm sounds and other system settings. 

 
The Heat Map module provides the display of the heat map statistics. 

 
The People Counting module provides the display of the people counting statistics. 

 
The Counting module provides the display of the counting statistics. 
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The Road Traffic module provides the display of the road traffic data. 

 

VCA Search for Picture module provides the query of the picture of face, license plate 

number and behavior analysis. 

Note: The Video Wall module only displays when Decoding Device is enabled for adding to the client. 

For details, please refer to Chapter 12 Decoding and Displaying Video on Video Wall. 

 

The function modules are easily accessed by clicking the navigation buttons on the control panel or by 

selecting the function module from the View or Tool menu. 

 

You can check the information, including current user, network usage, CPU usage, memory usage and 

time, in the upper-right corner of the main page. 

1.4 Updates Instruction  

Multiple newly-designed functions are offered in the latest iVMS-4200 client software. You can get a 

brief view of the updates instruction from the following contents. 

 Support Creating New Password for Devices 

For some devices, you are required to create the password to activate them before they can 

be added to the software and work properly. 

 Support Saving the Data of Heat Map 

The data of the heat map devices can be saved to your PC for local storage. 

 Add Counting Module 

You can check the counting statistics of the added counting device and the statistics can be 

displayed in line chart or histogram. 

 Add Road Traffic Module 

If you add road traffic monitoring device, the captured pictures of the detected vehicle or license 

plate can be searched and checked. Three types are available for searching the corresponding 

pictures. 

 Add VCA Search for Picture Module 

When the connected device supports face, behavior and license plate search, you can search the 

related picture and play the picture related video file. 
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Chapter 2  Live View 

2.1 User Registration and Login 

For the first time to use iVMS-4200 client software, you need to register a super user for login. 

Note: If the port 80 of your PC is occupied by other service, a dialog box will pop up. You should 

change the port No. to other value to ensure the proper running of the software. 

Steps: 

1. Input the super user name and password. 

2. Confirm the password. 

3. Optionally, check the checkbox Enable Auto-login to log into the software automatically. 

4. Click Register. Then, you can log into the software as the super user. 

 

 

 A user name cannot contain any of the following characters: / \ : * ? “ < > |. And the length of 

the password cannot be less than 6 characters. 

 For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product.  

 Proper configuration of all passwords and other security settings is the responsibility of the 

installer and/or end-user. 

When opening iVMS-4200 after registration, you can log into the client software with the registered 

user name and password. 

Steps: 

1. Input the user name and password you registered. 

Note: If you forget your password, please click Forgot Password and remember the encrypted 

string in the pop-up window. Contact your dealer and send the encrypted string to him to reset 

your password. 

2. Optionally, check the checkbox Enable Auto-login to log into the software automatically. 

3. Click Login. 
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After running the client software, a wizard will pop up to guide you to add the device and do some 

basic settings. For detailed configuration about the wizard, please refer to the Quick Start Guide of 

iVMS-4200. 

2.2 Adding the Device 

Purpose: 

After running the iVMS-4200, devices including network cameras, video encoders, DVRs, NVRs, 

decoder, etc., should be added to the client for the remote configuration and management, such as 

live view, playback, alarm settings, etc.  

Perform the following steps to enter the Device Adding interface: 

1. Click the  icon on the control panel, 

or click Tools->Device Management to open the Device Management page. 

2. Click the Server tab. 

3. Click Encoding Device to enter Encoding Device Adding interface. 

Note: Here we take the adding of encoding device as an example. 

 

You can add the device in the following ways: 

 By detecting the online devices, see Section 2.2.2 Adding Online Devices. 

 By specifying the device IP address or domain name, see Section 2.2.3 Adding Devices Manually. 

 By specifying an IP segment, see Section 2.2.4 Adding Devices by IP Segment. 
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 By IP Server, see Section 2.2.5 Adding Devices by IP Server. 

 By HiDDNS, see Section 2.2.6 Adding Devices by HiDDNS. 

 Batch Adding Devices, see Section 2.2.7 Batch Adding Devices. 

2.2.1 Creating the Password 

Purpose: 

For some devices, you are required to create the password to activate them before they can be 

added to the software and work properly. 

Note: This function should be supported by the device. 

Steps: 

1. Enter the Device Management page. 

2. On the Device for Management or Online Device area, check the device status (shown on 

Security column) and select an inactive device. 

 

 

3. Click the Activate button to pop up the Activation interface. 

4. Create a password in the password field, and confirm the password. 

 

STRONG PASSWORD RECOMMENDED– We highly recommend you create a strong 

password of your own choosing (using a minimum of 8 characters, including upper case 

letters, lower case letters, numbers, and special characters) in order to increase the security 

of your product. And we recommend you reset your password regularly, especially in the 

high security system, resetting the password monthly or weekly can better protect your 

product. 



User Manual of iVMS-4200 

13 
 

 

5. Click OK to create the password for the device. A “The device is activated.” window pops up 

when the password is set successfully. 

6. Click Modify Netinfo to pop up the Modify Network Parameter interface. 

Note: This function is only available on the Online Device area. You can change the device IP 

address to the same subnet with your computer if you need to add the device to the 

software. 

7. Change the device IP address to the same subnet with your computer by either modifying 

the IP address manually or checking the checkbox of DHCP. 

8. Input the password set in step 4 and click OK to complete the network settings. 

 

2.2.2 Adding Online Devices 

Purpose: 

The active online devices in the same local subnet with the client software will be displayed on the 

Online Device area. You can click the Refresh Every 15s button to refresh the information of the 

online devices. 

Note: You can click  to hide the Online Device area. 
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Steps:  

1. Select the devices to be added from the list. 

Note: For the inactive device, you need to create the password for it before you can add the 

device properly. For detailed steps, please refer to Section 2.2.1 Creating the Password. 

2. Click Add to Client to open the device adding dialog box. 

3. Input the required information. 

Nickname: Edit a name for the device as you want. 

Address: Input the device’s IP address. The IP address of the device is obtained automatically in 

this adding mode. 

Port: Input the device port No.. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and 

special characters) in order to increase the security of your product. And we recommend you 

reset your password regularly, especially in the high security system, resetting the password 

monthly or weekly can better protect your product. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All 

the channels of the device will be imported to the corresponding group by default. 

Note: iVMS-4200 also provides a method to add the offline devices. Check the checkbox Add 

Offline Device, input the required information and the device channel number and alarm input 

number, and then click Add. When the offline device comes online, the software will connect it 

automatically. 

5. Click Add to add the device. 
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Add Multiple Online Devices 

If you want to add multiple online devices to the client software, click and hold Ctrl key to select 

multiple devices, and click Add to Client to open the device adding dialog box. In the pop-up message 

box, enter the user name and password for the devices to be added. 

Add All the Online Devices 

If you want to add all the online devices to the client software, click Add All and click OK in the pop-up 

message box. Then enter the user name and password for the devices to be added. 

 

Modify Network Information 

Select the device from the list, click Modify Netinfo, and then you can modify the network 

information of the selected device. 

Note: You should enter the admin password the device in the Password field of the pop-up window to 

modify the parameters. 

Reset Password 

According to the different devices, the software provides three different methods for restoring the 

default password or resetting the password. 

Select the device from the list, click Reset Password. 

Option 1: 

If the window with security code field pops up, input the security code, and then you can restore the 
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default password of the selected device. 

Note: The security code is returned after you send the data and serial No. of the device to the 

manufacturer. 

Option 2:  

If the window with import file and export file buttons pops up, perform the following steps to restore 

the default password: 

1. Click Export to save the device file on your PC. 

2. Send the file to our technical engineers.  

3. Click Import and select the file received from the technical engineer. 

4. Click OK to restore the default password of the device. 

 

 The default password (12345) for the Admin account is for first-time log-in purposes only. You 

must change this default password to better protect against security risks, such as the 

unauthorized access by others to the product that may prevent the product from functioning 

properly and/or lead to other undesirable consequences. 

 For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product.  

 Proper configuration of all passwords and other security settings is the responsibility of the 

installer and/or end-user. 

Option 3: 

If the window with import file and export file buttons, password and confirm password field pops up, 

follow the steps below to reset the password: 

1. Click Export to save the device file on your PC. 

2. Send the file to our technical engineers. 

3. Click Import and select the file received from the technical engineer. 

4. Input new password in text fields of Password and Confirm Password. 

5. Click OK to reset the password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and 

special characters) in order to increase the security of your product. And we recommend you 

reset your password regularly, especially in the high security system, resetting the password 

monthly or weekly can better protect your product. 

2.2.3 Adding Devices Manually 

Steps: 

1. Click Add Device to open the device adding dialog box. 
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2. Select IP/Domain as the adding mode. 

3. Input the required information. 

Nickname: Edit a name for the device as you want. 

Address: Input the device’s IP address or domain name. 

Port: Input the device port No.. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and 

special characters) in order to increase the security of your product. And we recommend you 

reset your password regularly, especially in the high security system, resetting the password 

monthly or weekly can better protect your product. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All 

the channels of the device will be imported to the corresponding group by default. 

Note: iVMS-4200 also provides a method to add the offline devices. Check the checkbox Add 

Offline Device, input the required information and the device channel number and alarm input 

number, and then click Add. When the offline device comes online, the software will connect it 

automatically. 

5. Click Add to add the device. 

 

 

2.2.4 Adding Devices by IP Segment 

Steps: 

1. Click Add Device to open the device adding dialog box. 

2. Select IP Segment as the adding mode. 

3. Input the required information.  
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Start IP: Input a start IP address. 

End IP: Input an end IP address in the same network segment with the start IP. 

Port: Input the device port No.. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and 

special characters) in order to increase the security of your product. And we recommend you 

reset your password regularly, especially in the high security system, resetting the password 

monthly or weekly can better protect your product. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device IP. All the 

channels of the device will be imported to the corresponding group by default. 

Note: iVMS-4200 also provides a method to add the offline devices. Check the checkbox Add 

Offline Device, input the required information and the device channel number and alarm input 

number, and then click Add. When the offline device comes online, the software will connect it 

automatically. 

5. Click Add, and the device of which the IP address is between the start IP and end IP will be added 

to the device list. 

 

 

2.2.5 Adding Devices by IP Server 

Steps: 

1. Click Add Device to open the device adding dialog box. 

2. Select IP Server as the adding mode. 

3. Input the required information. 

Nickname: Edit a name for the device as you want. 
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Server Address: Input the IP address of the PC that installs the IP Server. 

Device ID: Input the device ID registered on the IP Server. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and 

special characters) in order to increase the security of your product. And we recommend you 

reset your password regularly, especially in the high security system, resetting the password 

monthly or weekly can better protect your product. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All 

the channels of the device will be imported to the corresponding group by default. 

Note: iVMS-4200 also provides a method to add the offline devices. Check the checkbox Add 

Offline Device, input the required information and the device channel number and alarm input 

number, and then click Add. When the offline device comes online, the software will connect it 

automatically. 

5. Click Add to add the device. 

 

 

2.2.6 Adding Devices by HiDDNS 

Steps: 

1. Click Add Device to open the device adding dialog box. 

2. Select HiDDNS as the adding mode. 

3. Input the required information. 

Nickname: Edit a name for the device as you want. 

Server Address: www.hik-online.com. 

Device Domain Name: Input the device domain name registered on HiDDNS server. 

http://www.hik-online.com/
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User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and 

special characters) in order to increase the security of your product. And we recommend you 

reset your password regularly, especially in the high security system, resetting the password 

monthly or weekly can better protect your product. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All 

the channels of the device will be imported to the corresponding group by default. 

Note: iVMS-4200 also provides a method to add the offline devices. Check the checkbox Add 

Offline Device, input the required information and the device channel number and alarm input 

number, and then click Add. When the offline device comes online, the software will connect it 

automatically. 

5. Click Add to add the device. 

 

2.2.7 Batch Adding Devices 

Purpose: 

The devices can be added to the software in batch by inputting the device information in the 

pre-defined CSV file. 

Steps: 

1. Click Add Device to open the device adding dialog box. 

2. Select Batch Import as the adding mode. 

3. Click Export Template and save the pre-defined template (CSV file) on your PC. 

4. Open the exported template file and input the required information of the devices to be added 

on the corresponding column. 

Nickname: Edit a name for the device as you want. 
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Adding Mode: You can input 0, 2, or 3 which indicated different adding modes. 0 indicates that 

the device is added by IP address or domain name; 2 indicates that the device is added via IP 

server; 3 indicates that the device is added via HiDDNS. 

Address: Edit the address of the device. If you set 0 as the adding mode, you should input the IP 

address or domain name of the device; if you set 2 as the adding mode, you should input the IP 

address of the PC that installs the IP Server; if you set 3 as the adding mode, you should input 

www.hik-online.com. 

Port: Input the device port No.. The default value is 8000. 

Device Information: If you set 0 as the adding mode, this field is not required; if you set 2 as the 

adding mode, input the device ID registered on the IP Server; if you set 3 as the adding mode, 

input the device domain name registered on HiDDNS server. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

The password strength of the device can be checked by the software. For your privacy, we 

strongly recommend changing the password to something of your own choosing (using a 

minimum of 8 characters, including upper case letters, lower case letters, numbers, and 

special characters) in order to increase the security of your product. And we recommend you 

reset your password regularly, especially in the high security system, resetting the password 

monthly or weekly can better protect your product. 

Add Offline Device: You can input 1 to enable adding the offline device, and then the software 

will automatically connect it when the offline device comes online. 0 indicates disabling this 

function. 

Export to Group: You can input 1 to create a group by the device name (nickname). All the 

channels of the device will be imported to the corresponding group by default. 0 indicates 

disabling this function. 

Channel Number: If you set 1 for Add Offline Device, input the channel number of the device. If 

you set 0 for Add Offline Device, this field is not required. 

Alarm Input Number: If you set 1 for Add Offline Device, input the alarm input number of the 

device. If you set 0 for Add Offline Device, this field is not required. 

5. Click  and select the template file. 

6. Click Add to import the devices. 

http://www.hik-online.com/
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The devices will be displayed on the device list for management after added successfully. You can 

check the resource usage, HDD status, recording status, and other information of the added devices 

on the list. 

Click Refresh All to refresh the information of all added devices. You can also input the device name in 

the filter field for search. 

Select device from the list, click Modify/Delete, and then you can modify/delete the information of 

the selected device. 

Select device from the list, click Remote Config, and then you can do some remote configurations of 

the selected device if needed. For detailed settings about the remote configuration, please refer to 

the User Manual of the devices. 

2.2.8 QR Code of Encoding Devices 

Purpose:  

For encoding devices, the QR code of the devices can be generated. You can add the device to 

your mobile client software by using the mobile client software to scan the QR code. For adding 

the devices to your mobile client software, please refer to the User Manual of the mobile client 

software. 

Check the QR Code 

On the device list, double-click a device, the information and QR code of the device will be 

displayed. 

Or you can click to select a device and click QR Code to pop up the QR code window of the 

device. 

You can also click and hold the Ctrl key to select multiple devices, and click QR Code to pop up 

the QR code window of the devices. In this way, you can add multiple devices at the same time 

by scanning the QR code. 
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2.3 Group Management 

Purpose: 

The devices added should be organized into groups for a convenient management. You can get the live 

view, play back the record files, and do some other operations of the device through the group. 

Before you start: 

Devices need to be added to the client software for group management. 

 

Perform the following steps to enter the Group Management interface: 

1. Open the Device Management page. 

2. Click the Group tab to enter the Group Management interface. 

 

 

Adding the Group 
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Steps:  

1. Click  to open the Add Group dialog box. 

2. Input a group name as you want. 

3. Click OK to add the new group to the group list. 

You can also check the checkbox Create Group by Device Name to create the new group by the 

name of the selected device. 

 

 

Importing Encoding Device to Group 

Steps: 

1. Click Import on Group Management interface, and then click the Encoding Channel tab to open 

the Import Encoding Channel page. 

Note: You can also select Alarm Input tab and import the alarm inputs to group. 

2. Select the thumbnails/names of the cameras in the thumbnail/list view. 

3. Select a group from the group list. 

4. Click Import to import the selected cameras to the group. 

You can also click Import All to import all the cameras to a selected group. 

Notes:  

 You can also click the icon  on the Import Encoding Channel page to add a new group. 

 Up to 64 cameras can be added to one group. 

 

 

The following buttons are available on the Import Encoding Channel page: 

 List View View the camera in list view. 

 Thumbnail View View the camera in thumbnail view. 
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 Refresh Refresh the latest information of added cameras. 

 Import Create a group named as device name-Encoding Channel 

(Alarm Input) and import the device to group. 

  Collapse/Expand Collapse/Expand the thumbnails of cameras. 

 

Modifying the Group/Camera 

Steps: 

1. Select the group/camera from the group list on the Import Encoding Channel page. 

2. Move the mouse to the camera/group and click , or double-click the group/camera name to 

open Modify Group/Camera dialog box. 

3. Edit the group/camera information, including the group/camera name, the stream type, etc. 

Video Stream: Select the stream for the camera as desired. 

Protocol Type: Select the transmission protocol for the camera. 

Stream Media Server: Configure to get stream of the camera via stream media server. You can 

select and manage the available stream media server. 

Copy to…: Copy the configured parameters to other camera(s). 

Refresh: Get a new captured picture for the live view of the camera. 

Note: For video stream and protocol type, the new settings will take effect after you reopen the 

live view of the camera.  

4. Click OK to save the new settings. 

You can also double-click the group/camera name on the Group Management interface to open 

the Modify Group/Camera dialog box. 

  
 

Removing Cameras from the Group 

Steps: 

1. Select the camera from the group list on the Import Encoding Channel page. 

2. Move the mouse to the camera and click  to remove the camera from the group. 

You can also select the camera on the Group Management interface, and then click Delete to 

remove the camera from the group. 

Select the group from the group list on the Import Encoding Channel page, move the mouse to 

the group and click  and you can remove all the cameras from the group. 
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Deleting the Group 

Steps: 

1. Select the group on the Group Management interface 

2. Click Delete Group, or move the mouse to the group and click the icon , the selected group 

and the resource under it will be deleted. 

2.4 Basic Operations in Live View 

Purpose: 

For the surveillance task, you can view the live video of the added network cameras and video 

encoders on the Main View page. And some basic operations are supported, including picture 

capturing, manual recording, PTZ control, etc. 

Before you start: 

A camera group is required to be defined for live view. 

Click the  icon on the control panel, 

or click View->Main View to open the Main View page. 

 

 

Main View Page 

1 View List 

2 Camera List 

3 PTZ Control Panel 

4 Display Window of Live View 

5 Live View Toolbar 

 

Camera Status: 

 The camera is online and works properly. 

 The camera is in live view. 
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 The camera is in recording status. 

 The camera is offline. 

Note: If event (e.g., motion detection) is detected for the camera, the camera icon will display as  

and the group icon will show as . 

 

Live View Toolbar: 

 

On the Main View page, the following toolbar buttons are available: 

 Save View Save the new settings for the current view. 

 Save View as Save the current view as another new view. 

 Stop Live View Stop the live view of all cameras. 

  Mute/Audio On Turn off/on the audio in live view 

  
Resume/Pause 

Auto-switch 
Click to resume/pause the auto-switch in live view. 

 Show /Hide the Menu 
Show/Hide the configuration menu of auto-switch. Click again to 

hide. 

 Previous Go for live view of the previous page. 

 Next Go for live view of the next page. 

 Window Division Set the window division. 

 Full Screen Display the live view in full-screen mode. Press ESC to exit. 

 

Right-click on the display window in live view to open the Live View Management Menu: 

 

 

The following buttons are available on the right-click Live View Management Menu: 

 Stop Live View Stop the live view in the display window. 

 Capture Capture the picture in the live view process. 

 Print Captured Picture Capture the current picture and then print the picture. 

 Send Email 
Capture the current picture and then send an Email notification to 

one or more receivers. The captured picture can be attached. 

  Start/Stop Recording Start/Stop the manual recording. The record file is stored in the PC. 

 Open PTZ Control Enable PTZ control function on the display window. Click again to 
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disable the function. 

 Enable Auto-tracking 

Enable the auto-tracking function of the speed dome. Then the 

speed dome will track the object appearing on the video 

automatically. This button is only available for the speed dome that 

supports the auto-tracking function.  

 Open Digital Zoom Enable the digital zoom function. Click again to disable the function. 

 
Switch to Instant 

Playback 
Switch to instant playback mode.  

  
Start/Stop Two-way 

Audio 
Click to start/stop the two-way audio with the device in live view. 

  
Start/Stop IP Two-way 

Audio 

Click to start/stop the two-way audio with the camera in live view. 

This button is only available for the camera that supports the IP 

two-way audio function. 

  Enable/Disable Audio Click to enable/disable the audio in live view. 

 Camera Status 
Display the status of the camera in live view, including the recording 

status, signal status, connection number, etc. 

 Remote Config Open the remote configuration page of the camera in live view. 

 VCA Config 
Enter the VCA configuration interface of the device if it is VCA 

device. 

 Synchronization Sync the camera in live view with the PC running the client software. 

 Batch Time Sync Set time synchronization for devices in batch. 

 Fisheye Expansion 

Enter the fisheye expansion mode. Only available when the device is 

fisheye camera. For details, please refer to Section 2.4.7 Live View in 

Fisheye Mode. 

  
Start/Stop Speed 

Dome linkage 

Click to start/stop locating or tracking the target according to your 

demand. Only available when the device is fisheye camera. For 

details, please refer to Section 2.4.8 Starting Speed Dome Linkage. 

 Full Screen Display the live view in full screen mode. Click the icon again to exit. 

 

2.4.1 Starting and Stopping the Live View 

Starting Live View for One Camera 

Steps: 

1. Open the Main View page. 

2. Optionally, click the  icon in live view toolbar to select the window division mode for live view. 

3. Click-and-drag the camera to the display window, 

or double-click the camera name after selecting the display window to start the live view. 

Note: You can click-and-drag the video of the camera in live view to another display window if 

needed. 

Starting Live View for Camera Group 

Steps: 
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1. Open the Main View page. 

2. Click-and-drag the group to the display window, 

or double-click the group name to start the live view. 

Note: The display window number is self-adaptive to the camera number of the group. 

Starting Live View in Default View Mode 

Purpose: 

The video of the added cameras can be displayed in different view modes. 4 frequently-used default 

view modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen. 

Steps: 

1. Open the Main View page. 

2. Click the icon  to expand the default view list. 

3. Click to select the default view mode and the video of the added cameras will be displayed in a 

sequence in the selected view. 

Note: Click , and you can save the default view as a custom view. 

Move the mouse to the view and the following icons are available: 

 Start Instant Playback Start the instant playback of the view. 

 Start Auto-switch Start switching automatically of the view. For details, 

please refer to Section 2.4.2 Auto-switch in Live View. 

Starting Live View in Custom View Mode 

Purpose: 

The view mode can also be customized for the video live view. 

Steps: 

1. Open the Main View page. 

2. Click the icon  to expand the custom view list. If there is custom view available, you can click 

to start live view of the custom view. 

3. Click  to create a new view. 

4. Input the view name and click Add. The new view is of 4-Screen mode by default. 

5. Optionally, click the  icon in live view toolbar and select the screen layout mode for the new 

view. 

6. Click-and-drag the camera/group to the display window, 

or double-click the camera/group name in custom view mode to start the live view. 

7. Click the icon  to save the new view. You can also click  to save the view as another 

custom view. 

 

Move the mouse to the custom view and the following icons are available: 

 Edit View Name Edit the name of the custom view. 

 Delete View Delete the custom view. 

 Start Instant Playback Start the instant playback of the view. 

Stopping the Live View 

Steps: 

1. Select the display window. 
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2. Click the icon  that appears in the upper-right corner when the mouse pointer is over the 

display window, 

or click Stop Live View on the right-click menu to stop the live view of the display window. 

You can also click the button  in live view toolbar to stop all the live view. 

2.4.2 Auto-switch in Live View 

Camera Auto-switch 

Purpose: 

The video stream of the cameras from the same group will switch automatically in a selected display 

window in camera auto-switch.  

Steps: 

1. Open the Main View page. 

2. Select a display window for camera auto-switch. 

3. Click the icon  in the toolbar and select or customize the switching interval. 

4. Select a group and click the icon  on the group node. 

5. You can click the icon /  to pause/resume the camera auto-switch. 

Single View Auto-switch 

Purpose: 

The video of all the cameras on the camera list will switch automatically in a selected default view in 

single view auto-switch. 

Steps: 

1. Open the Main View page. 

2. Click the icon  in the toolbar and select or customize the switching interval. 

3. Select a default view and click the icon  on the selected view node. 

4. You can click the icon /  to pause/resume the single view auto-switch. 

Multi-view Auto-switch 

Purpose: 

The custom views will switch automatically in multi-view auto-switch. The custom views need to be 

added before proceeding. 

Steps: 

1. Open the Main View page. 

2. Click the icon  in the toolbar and select the switching interval. 

3. Click the icon  on the custom view node. 

4. You can click the icon /  to pause/resume the multi-view auto-switch. 

2.4.3 PTZ Control in Live View  

The software provides PTZ control for cameras with pan/tilt/zoom functionality. You can set the preset, 

patrol and pattern for the cameras on the PTZ Control panel. And you can also open window PTZ 
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control for the operations of PTZ cameras. 

Click the icon  to expand the PTZ Control panel. 

 
 

The following buttons are available on the PTZ Control panel: 

 Zoom 

 Focus 

 Iris 

 Auxiliary Focus 

 3D Positioning 

 Light 

 Wiper 

 Lens Initialization 

 Menu 

 Manual Tracking 

Notes: 

 For the analog speed dome, you can click  to display its local menu. For detailed operation of 

the menu, please refer to the User Manual of the speed dome. 

 For the speed dome with auto-tracking function, you can enable the auto-tracking (via right-click 

menu) for it and then click  to manually track the target by clicking on the video. 

Configuring the Preset 

A preset is a predefined image position which contains information of pan, tilt, focus and other 

parameters. 

Perform the following steps to add a preset: 

1. Click the Preset button to enter the PTZ preset configuration panel. 

2. Click the direction buttons and other buttons on the PTZ control panel to steer the camera to the 

desired view. 

3. Select a PTZ preset number from the preset list and click . 

4. Input the name of the preset in the pop-up dialog box. 

5. Click OK to save the settings. 

 

To call a configured preset, double-click the preset, or select the preset and click the icon . 

You also perform the following steps to call the preset. 
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Steps: 

1. Click to select a live view window. 

2. For preset 1-9, click the corresponding number key (e.g., 4) to call the preset. 

For other presets, click “[”, number keys (e.g., 124), and “]” to call the preset. 

To modify a configured preset, select the preset from the list and click the icon . 

To delete a configured preset, select the preset from the list and click the icon . 

  
 

Configuring the Pattern 

A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions. 

Perform the following steps to add a pattern: 

1. Click the Pattern button to enter the PTZ pattern configuration panel. 

2. Click  to start recording of this pattern path. 

3. Use the direction buttons to control the PTZ movement. 

4. Click  to stop and save the pattern recording.  

5. Click the icon  to call the pattern. To stop calling the pattern, click . 

 

 
 

Configuring the Patrol 

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed 

between two presets and the dwell time at the preset separately programmable. 
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Before you start: 

Two or more presets for one PTZ camera need to be added. 

Perform the following steps to add and call a patrol: 

1. Click the Patrol button to enter the PTZ patrol configuration panel. 

2. Select a track number from the drop-down list. 

3. Click  to add a preset, and set the dwell time and patrol speed for the preset. 

4. Repeat the above operation to add other presets to the patrol. 

5. Optionally, you can click  or  to edit or delete a preset in the patrol path. 

6. Click the icon  to call the patrol. To stop calling the patrol, click . 

Notes: 

 Up to 16 patrols can be configured. 

 The preset dwell time can be set to 1~30 sec, and the patrol speed can be set to level 1~40. 

  

2.4.4 Manual Recording and Capture 

Toolbar in Each Live View Display Window: 

 
 

In each live view display window, the following toolbar buttons are available: 

 Capture 
Capture the picture in the live view process. The capture picture 

is stored in the PC. 

  Start/Stop Recording Start/Stop manual recording. The record file is stored in the PC. 

 
Switch to Instant 

Playback 
Switch to the instant playback mode. 

 

Manual Recording in Live View 

Purpose: 

Manual Recording function allows you to record the live video on the Main View page manually and 

the record files are stored in the local PC. 

Steps: 

1. Move the mouse pointer to the display window in live view to show the toolbar. 

2. Click  in the toolbar of the display window or on the right-click Live View Management Menu 
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to start the manual recording. The icon  turns to . 

3. Click the icon  to stop the manual recording. 

A prompt box with the saving path of the video files you just recorded will pop up if all the 

operations succeed. 

Notes:  

 During the manual recording, an indicator  appears in the upper-right corner of the display 

window. 

 The saving path of video files can be set on the System Configuration interface. For details, see 

Section 10.2.3 File Saving Path Settings. 

Viewing Local Record Files  

Steps: 

1. Click File->Open Video File to open the Record Files page. 

2. Select the camera to be searched from the Camera Group list. 

3. Click the icon  to specify the start time and end time for the search. 

4. Click Search. The video files recorded between the start time and end time will be displayed. 

Select the video file, and click Delete. You can delete the video file. 

Select the video file, and click Email Linkage. You can send an Email notification with the selected 

video file attached. 

Select the video file, and click Save as. You can save a new copy of the video file. 

Note: To send an Email notification, the Email settings need to be configured before proceeding. For 

details, see Section 10.2.6 Email Settings. 

 

 

Double-click the video file and the video file can be played back locally. 
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The following buttons are available on the local playback page: 

  CIF/4CIF Display the video in cif/4cif resolution. 

 Full Screen Display the local playback page in full screen mode. 

 Close Close the local playback page of the record files. 

  Pause/Play Pause/Start the playback of the record files. 

 Stop Stop the playback of the record files. 

 Speed Set the playback speed.  

 Single Frame Play back the record files frame by frame. 

 Digital Zoom Enable the digital zoom function. Click again to disable. 

  Enable/Disable Audio Click to enable/disable the audio in the local playback. 

 Capture Capture the picture in the playback process. 

 

Capturing Picture in Live View 

Steps: 

1. Move the mouse pointer to the display window in live view to show the toolbar. 

2. Click the icon  in the toolbar of the display window or on the right-click Live View 

Management Menu. 

A small window of the captured picture will be displayed to notify whether the capturing 

operation is done or not.  

Note: The saving path of the captured pictures can be set on the System Configuration interface. For 

details, see Section 10.2.3 File Saving Path Settings. 

Viewing Captured Pictures 

The pictures captured in live view are stored in the PC running the software. You can view the 

captured pictures if needed. 

Steps: 

1. Click File->Open Captured Picture to open the Captured Picture page. 

2. Select the camera to be searched from the Camera Group list. 
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3. Click the icon  to specify the start time and end time for the search. 

4. Click Search. The pictures captured between the start time and end time will be displayed. 

5. Double-click the captured picture to enlarge it for a better view. 

Select the captured picture, and click Print. You can print the selected picture. 

Select the captured picture, and click Delete. You can delete the selected picture. 

Select the captured picture, and click Email Linkage. You can send an Email notification with the 

selected picture attached. 

Select the captured picture, and click Save as. You can save a new copy of the selected picture. 

 

 

2.4.5 Instant Playback 

Purpose: 

The record files can be played back instantly on the Main View page. Instant playback shows a piece of 

the video which was remarkable, or which was unclear on the first sight. Thus, you can get an 

immediate review if needed. 

Before you start: 

The video files need to be recorded on the storage devices, such as the SD/SDHC cards and HDDs on 

the DVRs, NVRs, Network Cameras, etc., or on the storage servers. 

Steps: 

1. Start the live view and move the mouse to the display window to show the toolbar. You can also 

move the mouse to default view or custom view and click  to enable the instant playback of 

the selected view. 

2. Click the icon  in the toolbar and a list of time periods pops up.  

30s, 1 min, 3 min, 5 min, 8 min, and 10 min are selectable. 

3. Select a time period to start the instant playback. 

Example: If the current time of the live view is 09:30:00, and you select 3 min, then the instant 

playback will start from 09:27:00. 

4. Click the icon  again to stop the instant playback and go back for the live view. 

Note: During the instant playback, an indicator  appears in the upper-right corner of the display 

window. 
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On the instant playback page, the following toolbar buttons are available: 

 Reverse Playback Play back the record file reversely. 

  
Pause/Start 

Playback 
Pause/Start the playback of the record files. 

 Stop Playback Stop the playback of all cameras. 

  
Slow Forward / Fast 

Forward 
Decrease / Increase the play speed of the playback. 

  
Single Frame 

(Reverse) 
Play back the record files frame by frame (reversely). 

 

Right-click on the display window to open the Instant Playback Management Menu: 

 
 

The following buttons are available on the right-click Instant Playback Management Menu: 

 Reverse Playback Play back the record file reversely. 

  Pause/Play Pause/Start the instant playback in the display window. 

 Stop Stop the instant playback and return to the live view mode. 

  
Fast Forward / Slow 

Forward 
Increase/Decrease the play speed of the instant playback. 

  Single Frame (Reverse) Play back the record file frame by frame (reversely). 

 Open Digital Zoom Enable the digital zoom function. Click again to disable the function. 

 Capture Capture the picture in the instant playback process. 
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 Print Captured Picture Capture the current picture and then print the picture. 

 Send Email 
Capture the current picture and then send an Email notification to 

one or more receivers. The captured picture can be attached. 

  Start/Stop Recording Start/Stop clipping the record files. 

  Enable/Disable Audio Click to turn on/off the audio in instant playback. 

 Switch to Live View Switch to live view mode.  

 Full Screen Display the instant playback in full screen mode. Click again to exit. 

 

2.4.6 Custom Window Division 

Purpose: 

The client software provides multiple kinds of pre-defined window division. You can also set custom 

window division as desired. 

Steps: 

1. Click  on the live view toolbar and select  to pop up the custom window division 

dialog box. 

 

2. Click Add to open the custom window division adding dialog box. 

Note: Up to 5 custom window divisions can be added. 

3. Set a name for the new window division as desired and click OK to save the settings. 

 

4. You can edit the name, window division (3x3, 4x4, 5x5) for it.  

5. Click-and-drag you mouse to select the adjacent windows, and click Joint to joint them as a 

whole window. You can also click Cancel to cancel the jointing. 
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6. Click Save to confirm the settings. Click  to back to the Main View page. Then you can 

click  and select the custom window division for playing live video. 

Notes: 

 You can also enter the Remote Playback page and perform the steps above to configure 

the custom window division. 

 For remote playback, up to 16 windows can be played back at the same time. The 

custom window division with more than 16 windows is invalid for playback. 

2.4.7 Live View in Fisheye Mode 

Purpose: 

The live video of the camera can be played in fisheye expansion mode. 

Steps: 

1. Start the live view (refer to Section 2.4.1 Starting and Stopping the Live View). 

2. Right-click on the video and select Fisheye Expansion. You can select the expand mode for 

playback as desired. 

Note: For some devices, you can select the mounting type of the device and the related expand 

mode will be listed. 
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 Fisheye: In the Fisheye view mode, the whole wide-angle view of the camera is displayed. 

This view mode is called Fisheye because it approximates the vision of a fish’s convex eye. 

The lens produces curvilinear images of a large area, while distorting the perspective and 

angles of objects in the image. 

 Panorama / Dual-180
o 

Panorama / 360
o
 Panorama: In the Panorama view mode, the 

distorted fisheye image is transformed to normal perspective image by some calibration 

methods. 

 PTZ: The PTZ view is the close-up view of some defined area in the Fisheye view or 

Panorama view, and it supports the electronic PTZ function, which is also called e-PTZ. 

Note: Each PTZ view is marked on the Fisheye view and Panorama view with a specific 

navigation box. You can drag the navigation box on the Fisheye view or Panorama view to 

adjust the PTZ view, or drag the PTZ view to adjust the view to the desired angle. 

PTZ Control 
In PTZ mode, you can use the PTZ control to adjust the PTZ window. 

Note: The PTZ panel varies according to different devices. 

 Select a PTZ window, and click one of the direction buttons to adjust the view angle. 

Note: Click-and-drag the No. label in the fisheye or panorama window will change the view angle 

of the PTZ window as well. 

 Select a PTZ window, and click  to start auto-scan, and click it again to stop auto-scan. 

 : Drag the slider to adjust the speed for PTZ movement. 

 : Zoom in or zoom out the selected PTZ window by clicking  or . Or you can 

scroll the mouse wheel to zoom in or zoom out. 

Preset 
Note: The preset is only supported by specific fisheye camera. 

A preset is a user-defined monitor position/point. You can simply call the preset No. to change the 

monitor scene to the defined position. Please follow the steps below to configure the preset. 

Steps: 

1. Click Preset tab to enter the preset configuration interface. 

2. Select a PTZ window, and adjust the scene to the place you want to mark as a preset. 

3. Click , input the preset name, and click OK to save a preset. 

 

4. (Optional) Click  to call the configured preset. 

5. (Optional) Click  to delete the configured preset. 

Patrol 
Note: The preset is only supported by specific fisheye camera. 

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed 

between two presets and the dwell time at the preset separately programmable. Please follow the 

steps below to configure the patrol. 

Note: 
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At least 2 presets have to be configured before you configure the patrol. 

Steps: 

1. Click patrol tab to enter the patrol configuration interface. 

2. Select a path No. from the drop-down list. 

3. Click  to add the configured presets, and set the dwell time and patrol speed for the preset. 

4. Repeat the above operation to add other presets to the patrol. 

 

5. Click  to start the patrol, and click  to stop patrol. 

6. Optionally, you can click  or  to edit or delete a preset in the patrol path. 

Notes: 

 Up to 256 presets can be configured. 

 Up to 32 patrols can be set. 

 The dwell time ranges from 1 to 120s. 

 The patrol speed ranges from 1 to 40. 

2.4.8 Starting Speed Dome Linkage 

Purpose: 

The fisheye camera supports speed dome linkage function so as to locate or tracking the target 

according to your demand. 

Notes: 

 This function in only supported by the specific fisheye camera. 

 A speed dome with the auto-tracking function is required to be installed near the fisheye 

camera. 

Steps: 

1. Right click on the panorama view and select Remote Config. Go to the Fisheye menu. 
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2. Select the mounting type of the speed dome, and select the stream mode for the fisheye camera. 

3. Click Login to add the speed dome.  

 

4. Input the device IP address, port No., username, password, and click Login. 

5. Click PTZ Control, and use the direction arrows to adjust the speed dome to a horizontal position. 

Note: 

If the speed dome is adjusted to the horizontal position, the tilt degree is close to 0. 

6. Click Horizon Line to set a horizon line, and a message of “Setting horizontal line succeeded” pops 

up if the line is set. 

7. Move the No.1 calibration cross to the middle area of the fisheye camera, and you will see a small 

picture under the fisheye camera. Use the PTZ to adjust the speed dome to the same position, 

and click Calibration 1 to finish a calibration setting. 

8. Move the No.2 calibration cross to the second position, and use the PTZ to adjust the speed dome 

to the same position, and click Calibration 2 to finish the second calibration setting. 

Note: 

You can click Clear to delete the configured calibrations. 

9. Click Link to link the speed dome to the fisheye camera. 

10. Click Tracking Parameters to select the tracking method.  

Notes: 

 The speed dome linkage works as the linkage method of the intrusion detection and line 

crossing detection if any of those alarms is triggered. 
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 Right click on the live view window of fisheye camera, and go to Remote 

Config >Event >Intrusion/ Line Crossing to check the checkbox Smart Tracking to enable the 

tracking function. 

11. Click Save to save the settings 

12. (Optional) You can also right click on the panorama view and select Start Speed Dome linkage. 

Then you can make the speed dome to track target manually by clicking the target on the live 

view of fisheye camera. 

Note: If you want to see the speed dome linkage, you should add the speed dome to the software 

(Section 2.2 Adding the Device) and start live view (Section 2.4.1 Starting and Stopping the Live 

View) of it. 

2.4.9 Other Functions in Live View 

There are some other functions supported in the live view, including digital zoom, two-way audio, 

camera status and synchronization. 

Auxiliary Screen Preview 

The live video can be displayed on different auxiliary screens for the convenient preview of multiple 

monitoring scenes. Up to 3 auxiliary screens are supported. 

Digital Zoom 

Use the left key of mouse to drag a rectangle area in the lower-right/upper-left direction, and then the 

rectangle area will zoom in/out. 

Channel-zero 

For the channel-zero of the device, you can hold the Ctrl key and double-click to display the specific 

channel. Hold the Ctrl key and double-click again to restore. 

Two-way Audio 

Two-way audio function enables the voice talk of the camera. You can get not only the live video but 

also the real-time audio from the camera. This two-way audio can be used for only one camera at one 

time. 

Camera Status 

The camera status, such as recording status, signal status, connection number, etc., can be detected 

and displayed for check. The status information refreshes every 10 seconds.  

Synchronization 

The synchronization function provides a way to synchronize the device clock with the PC which runs 

the client software.  
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Chapter 3  Remote Storage Schedule 

Settings and Playback 

When the video storage devices are the HDDs, Net HDDs, SD/SDHC cards on the local device, or the 

remote storage server connected, you can set the record schedule or capture schedule for the 

cameras for the continuous, alarm triggered or command triggered recording or capture. And the 

record files can be searched for the remote playback. 

3.1 Remote Storage 

Purpose: 

The video files and captured pictures can be stored on the HDDs, Net HDDs, SD/SDHC cards on the 

local device, or the storage server connected. 

Click the  icon on the control panel, 

or click Tool->Storage Schedule to open the Storage Schedule page. 

 
 

3.1.1 Storing on Storage Devices on the DVRs, NVRs, or 

Network Cameras 

Purpose: 

Some local devices, including the DVRs, NVRs, and Network Cameras, provide storage devices such as 

the HDDs, Net HDDs and SD/SDHC cards for record files. You can set a record schedule or capture 

schedule for the channels of the local devices. 

Note: The pictures captured through the capture schedule are stored on the local device and can be 

searched on the remote configuration page of the device. 
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Before you start: 

The newly installed storage devices need to be formatted. Go to the remote configuration page of the 

device, click Storage->General, select the HDD or SD/SDHC card, and click Format to initialize the 

selected storage device. 

Steps: 

1. Open the Record Schedule page. 

2. Select the camera in the Camera Group list. 

3. Check the checkbox Record Schedule / Capture Schedule under Storage of Encoding Server to 

enable device local recording or capture. 

 

4. Select the record or capture schedule template from the drop-down list. 

All-day Template: for all-day continuous recording. 

Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM. 

Event Template: for the event triggered recording. 

Template 01-08: fixed templates for specific schedules. You can edit the templates if needed. 

Custom: can be customized as desired. 

If you need to edit or customize the template, see Configuring Record Schedule Template. 

5. Click Advanced Settings to set the recording parameters. For details, see Table 3.1 Advanced 

Recording Settings and Table 3.2 Advanced Capture Settings. 

6. Optionally, click Copy to… to copy the record schedule settings to other channels. 

7. Click Save to save the settings. 

  

 

 

 

Table 3.1 Advanced Recording Settings 

Parameters Descriptions 



User Manual of iVMS-4200 

46 
 

Pre-record 
Normally used for the event triggered record, when you want to record before 

the event happens 

Post-record After the event finished, the video can also be recorded for a certain time. 

Keep Record Files 

for 

The time for keeping the record files in the storage device, once exceeded, the 

files will be deleted. The files will be saved permanently if the value is set as 0. 

Redundant Record Save the video files not only in the R/W HDD but also in the redundant HDD. 

Record Audio Record the video files with audio or not. 

Video Stream Select the stream type for the recording. 

Table 3.2 Advanced Capture Settings 

Parameters Descriptions 

Resolution Select the resolution for the continuous or event captured pictures. 

Picture Quality Set the quality for the continuous or event captured pictures. 

Interval 
Select the interval which refers to the time period between two capturing 

actions. 

 

 

Configuring Record Schedule Template 

Perform the following steps to configure the record schedule template: 

If Template 01-08 is selected from the drop-down list, start from step 1; 

If Custom is selected from the drop-down list, start from step 2. 

1. Click Edit to enter the Templates Management interface. Select the template to be set and you 

can edit the template name. 

2. Set the time schedule for the selected template. 

 refers to normal schedule record. The schedule time bar is marked with . 

 refers to the schedule record for the event. The schedule time bar is marked 

with . 

 refers to the schedule record triggered by command. The schedule time bar is 

marked with . 

Note: Record triggered by command is only available for the ATM transactions when the ATM DVR 

is added to iVMS-4200. 

When the cursor turns to , you can set the time period. 

When the cursor turns to , you can move the selected time bar you just edited. You can also 

edit the displayed time point to set the accurate time period. 

When the cursor turns to , you can lengthen or shorten the selected time bar. 

3. Optionally, you can select the schedule time bar,  

and then click the icon  to delete the selected time bar, 

or click the icon  to delete all the time bars, 

or click the icon  to copy the time bar settings to the other dates. 

4. Click OK to save the settings.  

You can click Save as Schedule Template on the Custom Schedule interface, and then the custom 

template can be saved as template 01--08. 

Note: Up to 8 time periods can be set for each day in the record schedule. 
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3.1.2 Storing on Storage Device 

Purpose: 

You can add storage device to the client for storing the record files and pictures of the added encoding 

devices and you can search the files for remote playback. The storage device can be storage server, 

CVR or other NVR. Here we take the settings of storage server as an example. 

Before you start: 

The storage server application software needs to be installed and it is packed in the iVMS-4200 

software package. When installing the iVMS-4200, check the checkbox Storage Server to enable the 

installation of storage server. 

Adding the Storage Server 

Steps: 

1. Click the shortcut icon  on the desktop to run the storage server. 

Note: You can also record the video files on the storage server installed on other PC. 
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2. Open the Device Management page and click the Server tab. 

3. Click Add New Device Type, select Storage Server and click OK. 

4. Click Storage Server on the list to enter the Storage Server Adding interface. 

 
 

You can add the storage server in the following ways: 

 By detecting the online storage server, see Section 2.2.2 Adding Online Devices. 

 By specifying the storage server IP address or domain name, see Section 2.2.3 Adding Devices 

Manually. 

 By specifying an IP segment, see Section 2.2.4 Adding Devices by IP Segment. 

 By IP Server, see Section 2.2.5 Adding Devices by IP Server. 

Formatting the HDDs 

The HDDs of the storage server need to be formatted for the record file and picture storage. 

Steps: 

1. Select the added storage server from the list and click Remote Config. 

2. Click Storage->General, to enter the HDD Formatting interface. 

3. Select the HDD from the list and click Format. You can check the formatting process from the 

process bar and the status of the formatted HDD changes from Unformatted to Normal Status. 

Note: Formatting the HDDs is to pre-allocate the disk space for storage and the original data of the 

formatted HDDs will not be deleted. 

 

 

Configuring Storage Schedule 
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Before you start: 

The storage server needs to be added to the client software and the HDDs need to be formatted for 

the record file storage. 

Steps: 

1. Open the Storage Schedule page. 

2. Select the camera from the Camera Group list. 

3. Select the storage server from the Storage Server drop-down list. 

Note: You can click Storage Server Management to add, edit or delete the storage server. 

4. Check the checkbox Record Schedule to enable storing the record files. 

You can also check the checkbox Picture Storage to store the alarm pictures of the camera when 

event occurs. 

For the network cameras with the function of heat map or people counting, the Additional 

Information Storage checkbox is available. You can click VCA Config to set the VCA rule for the 

camera, and check the Additional Information Storage checkbox and the heat map, people 

counting data and road traffic data will be uploaded to the storage server. Please refer to Chapter 

13 Heat Map, Chapter 14 People Counting Statistics and Chapter 16 Road Traffic for checking the 

data. 

Note: For detailed configuration about setting the VCA rule, please refer to the User Manual of 

the camera. 

5. Select the schedule template for recording from the drop-down list. 

If you need to edit or customize the template, see Configuring Record Schedule Template. 

6. Click Advanced Settings to set the pre-record time, post-record time and other parameters for 

recording. 

7. Click Set Quota to enter the HDD management interface of the storage server. You can set the 

corresponding quota ratio for record, picture and additional information. 

Example: If you set the record quota as 60%, then the 60% of the storage space can be used for 

storing the record files.  

8. Click Save to save the settings. 
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3.2 Remote Playback 

Purpose: 

The record files stored on the local device or the storage server can be searched by camera or 

triggering event, and then can be played back remotely. 

Click the  icon on the control panel, 

or click View->Remote Playback to open the Remote Playback page. 

 

 

Remote Playback Page 

1 Camera List 

2 Display Window of Playback 

3 Playback Control Buttons 

4 Timeline 

5 Calendars 

6 Search Condition 

3.2.1 Normal Playback 

Purpose: 

The record files can be searched by camera or group name for the Normal Playback. 

Searching Record Files for Normal Playback 

Steps: 

1. Open the Remote Playback page. 

2. Click-and-drag the camera or group to the display window, 

or double-click the camera or group to start the playback. 

3. The found record files of the selected group or camera will be displayed on the right of the 

interface. You can filter the results through the Filter text field. 
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4. (Optional) Click the calendars icon  to activate the calendars dialog box. 

Select the date and set the accurate time. 

Click OK and the record files of the 7 days near to the configured date will be searched and 

displayed. 

Note: Up to 16 cameras can be searched simultaneously. 

 

 

Playing Back Record Files 

After searching the record files for the normal playback, you can play back the record files in the 

following two ways: 

 Playback by File List 

Select the record file from the search result list, and then click the icon  on the record file, 

or double-click the record file to play the video on the display window of playback. 

You can also select a display window and click the icon  in the toolbar to play back the 

corresponding record file. 

 Playback by Timeline 

The timeline indicates the time duration for the record file, and the record files of different types 

are color coded. Click on the timeline to play back the video of the specific time. 

You can click  or  to scale up or scale down the timeline bar. 

You can drag the timeline bar to go to the previous or the next time period. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 
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Normal Playback Toolbar: 

 

On the Normal Playback page, the following toolbar buttons are available: 

 Reverse Playback Play back the record file reversely. 

  
Pause/Start 

Playback 
Pause / Start the playback of the record files. 

 Stop Playback Stop the playback of all cameras. 

 
Single Frame 

(Reverse) 
Play back the record files frame by frame reversely. 

 Single Frame Play back the record files frame by frame. 

  
Slow Forward / Fast 

Forward 
Decrease / Increase the play speed of the playback. 

  Volume Click to turn on/off the audio and adjust the audio volume. 

 Event Playback 
Search the recordings triggered by event, such as motion 

detection, video loss or video tampering. 

 ATM Playback Search the recordings of ATM devices. 

 VCA Playback 
Set the VCA rule to the searched record files that VCA event 

occurs, including VCA Search, Intrusion and Line Crossing. 

 Window Division Set the window division. 

 Full Screen 
Display the video playback in full-screen mode. Press ESC to 

exit. 

  
Async/Sync 

Playback 

Click to play back the record files 

synchronously/asynchronously. 

 Download 

Download the record files of the camera and the record 

files are stored in the PC. You can select to download by file 

or by date. 
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 Tag 

Add default tag for the video file to mark the important 

video point. You can edit the tag or go to the tag position 

via the right-click menu. 

 Filter 
Display the record types as desired. E.g., you can select to 

display only the event recording. 

 Date The day that has record files will be marked with . 

 

Right-click on the display window in playback to open the Playback Management Menu: 

 

The following items are available on the right-click Playback Management Menu: 

 Reverse Playback Play back the record file reversely. 

  Pause/Start Pause/Start the playback. 

 Stop Stop the playback. 

 Fast Forward Play back the record file at a faster speed. 

 Slow Forward Play back the record file at a slower speed. 

  Single Frame (Reverse) Play back the record file frame by frame (reversely). 

 Open Digital Zoom Enable the digital zoom function. Click again to disable the function. 

 Tag Control 

Add default (default tag name TAG) or custom tag (customized tag 

name) for the video file to mark the important video point. You can 

also edit the tag or go to the tag position conveniently. 

 Accurate Positioning Set the accurate time point to play back the record file. 

 Capture Capture the picture in the playback process. 

 Print Captured Picture Capture a picture and print it. 

 Send Email 
Capture the current picture and then send an Email notification to 

one or more receivers. The captured picture can be attached. 

  Start/Stop Recording Start/Stop the manual recording. The record file is stored in the PC. 

 Download 
Download the record files of the camera and the record files are 

stored in the PC. You can select to download by file or by date. 

  Enable/Disable Audio Click to enable/disable the audio in playback. 

 Fisheye Expansion 
Enter the fisheye playback mode. For details, please refer to Section 

3.2.6 Fisheye Playback. 

 Full Screen Display the playback in full-screen mode. Click the icon again to exit. 
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3.2.2 Event Playback 

Purpose: 

The recordings triggered by event, such as motion detection, VCA detection or behavior analysis, can 

be searched for Event Playback and this function requires the support of the connected device. 

Searching Record Files for Event Playback 

Steps: 

1. Open the Remote Playback page. 

2. Select the camera and start the normal playback. Refer to Section 3.2.1 Normal Playback. 

3. Click  and the motion detection triggered recording will be search by default. 

4. Select the event type from the drop-down list and the found record files will be displayed. You can 

filter the results through the Filter text field. Or you can click  to go back to the normal 

playback. 

5. (Optional) Click the calendars icon  to activate the calendars dialog box. 

Select the date and set the accurate time. Click OK and the record files of the 7 days near to the 

configured date will be searched and displayed. 

6. Select the record file from the search result list, and then click the icon  on the record file, or 

double-click the record file to play the video on the corresponding display window of playback. 

 

Playing Back Record Files 

After searching the recordings triggered by the event, you can play back the record files in the 

following two ways: 

 Playback by File List 

Select the record file from the search result list, and then click the icon  in the toolbar, or 

click the icon  on the record file, or double-click the record file to play the video on the 

corresponding display window of playback. 

 Playback by Timeline 

The timeline indicates the time duration for the record file. Click on the timeline to play back the 
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video of the specific time. 

You can click  or  to scale up or scale down the timeline bar. 

You can drag the timeline bar to go to the previous or the next time period. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 

Event Playback Toolbar: 

 

On the Remote Playback page, the following toolbar buttons are available: 

 Reverse Playback Play back the record file reversely. 

  
Pause/Start 

Playback 
Pause/Start the playback of the record files. 

 Stop Playback Stop the playback of all cameras. 

 
Single Frame 

(Reverse) 
Play back the record files frame by frame reversely. 

 Single Frame Play back the record files frame by frame. 

 Previous Event Go to the playback of the previous event. 

 Next Event Go to the playback of the next event. 

  
Slow Forward / Fast 

Forward 
Decrease / Increase the play speed of the playback. 

  Volume Click to turn on/off the audio and adjust the audio volume. 

 Full Screen 
Display the video playback in full screen mode. Press ESC to 

exit. 

 Download 
Download the record files of the camera and the record files 

are stored in the PC. 

 Date The day that has record files will be marked with . 

 

Please refer to Section 3.2.1 Normal Playback for the description of the right-click menu. Some icons 

may not available for event playback. 

3.2.3 ATM Playback 

Purpose: 

Search the record files for ATM DVR. 

Note: This function should be supported by the device and the device should be configured with 

transaction rules. For details, please refer to the User Manual of the device. 

Searching Record Files for ATM Playback 

Steps: 

1. Open the Remote Playback page. 

2. Select the camera of the ATM DVR and start the normal playback. Refer to Section 3.2.1 Normal 

Playback. 
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3. Click  to enter the ATM playback interface. 

4. Enter the search conditions. 

: Input the card number that is contained in the ATM information. 

: Check the checkbox and select the transaction type for query, and input the 

related transaction amount. 

File Type: Select the type of the record file to be searched. 

5. Click Search and the matched files will be displayed. You can filter the results through the 

Filter text field. 

6. (Optional) Click the calendars icon  to activate the calendars dialog box. 

Select the date and set the accurate time. You can also click Current Time to get the current time. 

Click OK and the record files of the 7 days near to the configured date will be searched and 

displayed. 

7. Double-click a file for playback. Or you can click  to go back to the normal playback. 

Playing Back Record Files 

After searching the recordings, you can play back the record files in the following two ways: 

 Playback by File List 

Select the record file from the search result list, and then click the icon  in the toolbar, or 

click the icon  on the record file, or double-click the record file to play the video on the 

corresponding display window of playback. 

 Playback by Timeline 

The timeline indicates the time duration for the record file. Click on the timeline to play back the 

video of the specific time. 

You can click  or to zoom in or zoom out the timeline bar. 

You can drag the timeline bar to go to the previous or the next time period. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 

Please refer to Section 3.2.1 Normal Playback for the description of the playback control toolbar 

and right-click menu. Some icons may not available for ATM playback. 

3.2.4 Synchronous Playback 

Purpose: 

In synchronous playback, the record files can be played back in synchronization. 

Note: Record files from up to 16 cameras can be played back simultaneously. 

Steps: 

1. Search the record files for the normal playback (Section 3.2.1 Normal Playback). At least two 

cameras are during playback. 

2. Click  in the toolbar to enable the synchronous playback. The camera under playback will 

start synchronous playback. 
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3. To disable the synchronous playback, click the icon . 

3.2.5 VCA Playback 

Purpose: 

You can set VCA rule to the searched record files and find the video that VCA event occurs, including 

VCA Search, Intrusion and Line Crossing. This function helps to search out the video that you may be 

more concerned, mark it with red color and the playback speed of the concerned video and 

unconcerned video can be customized. 

 VCA Search: Get all the related motion detection events that occurred in the pre-defined region. 

 Intrusion Detection: Detect whether there are people, vehicles and other moving objects 

intruding into the pre-defined region. 

 Line Crossing Detection: Bi-directionally detect people, vehicles and other moving objects that 

cross a virtual line. 

Note: For some devices, you can filter the searched video files by setting the advanced attributes, 

such as the gender and age of the human and whether he/she wears glasses. 

Steps: 

1. Open the Remote Playback page. 

2. Select the camera and start the normal playback. Refer to Section 3.2.1 Normal Playback. 

3. Click  to enter the VCA playback interface. 

4. Select the VCA Type, draw the detection region and set the sensitivity. 

Notes:  

 For VCA Search, click , and then click and move on the playback window to set the grid 

rectangle as the detection region. Or you can click  to set all the area shot by the 

camera as the detection region. 

 For Intrusion, click  and then click on the playback window to set the vertex for the 

detection region. 

 For Line Crossing, click  and then click-and-drag on the playback window to set the 

detection line. 

Note: For Intrusion and Line Crossing, you can click Advanced Attributes and check the 

checkbox to filter the searched video files by setting the target characters, such as the 
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gender and age of the human and whether he/she wears glasses. This function should 

be supported by the device. 

 To delete the drawn region or line, click  to remove it. 

5. Click Search and the VCA events occurred in the defined area will be red marked on the timeline. 

By default, the playback speed of concerned video will be 1X, and the playback speed of 

unconcerned video will be 8X. 

 

Playing Back Record Files 

After searching the recordings, you can play back the record files in the following two ways: 

 Playback by File List 

Select the record file from the search result list, and then click the icon  in the toolbar, or 

click the icon  on the record file, or double-click the record file to play the video on the 

corresponding display window of playback. 

 Playback by Timeline 

The timeline indicates the time duration for the record file. Click on the timeline to play back the 

video of the specific time. 

You can click  or to zoom in or zoom out the timeline bar. 

You can drag the timeline bar to go to the previous or the next time period. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 

Please refer to Section 3.2.1 Normal Playback for the description of the playback control toolbar and 

right-click menu. Some icons may not available for VCA playback. 

3.2.6 Fisheye Playback 

Purpose: 

The record files can be played back in fisheye expansion mode. 

Steps: 

1. Open the Remote Playback page. 

2. Select the camera and start the normal playback. Refer to Section 3.2.1 Normal Playback. 

3. Right-click on the playback video and select Fisheye Expansion to enter the Fisheye Expansion 

Mode. You can select the expand mode for playback as desired. 
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Note: For some devices, you can select the mounting type of the device and the related 

expansion mode will be listed. 

 Fisheye: In the Fisheye view mode, the whole wide-angle view of the camera is displayed. 

This view mode is called Fisheye because it approximates the vision of a fish’s convex eye. 

The lens produces curvilinear images of a large area, while distorting the perspective and 

angles of objects in the image. 

 Panorama / Dual-180
o 

Panorama / 360
o
 Panorama: In the Panorama view mode, the 

distorted fisheye image is transformed to normal perspective image by some calibration 

methods. 

 PTZ: The PTZ view is the close-up view of some defined area in the Fisheye view or 

Panorama view, and it supports the electronic PTZ function, which is also called e-PTZ. 

Note: Each PTZ view is marked on the Fisheye view and Panorama view with a specific 

navigation box. You can drag the navigation box on the Fisheye view or Panorama view to 

adjust the PTZ view, or drag the PTZ view to adjust the view to the desired angle. 

 

Right-click on a playing window and you can switch the selected window to full-screen mode. 

Press ESC key on the keyboard or right-click on the window and select Quit Full Screen to exit the 

full-screen mode. 

On the Normal Playback page, the following toolbar buttons are available: 

 Reverse Playback Play back the record file reversely. 

  
Pause/Start 

Playback 
Pause/Start the playback of the record files. 

 
Single Frame 

(Reverse) 
Play back the record files frame by frame reversely. 

 Single Frame Play back the record files frame by frame. 

  
Slow Forward / 

Fast Forward 
Decrease / Increase the play speed of the playback. 

  Volume Click to turn on/off the audio and adjust the audio volume. 

 Full Screen 
Display the video playback in full-screen mode. Press ESC to 

exit. 
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Chapter 4  Event Management 

Purpose: 

In iVMS-4200 client software, rules can be set up for triggers and linkage actions. You can assign 

linkage actions to the trigger by setting up a rule. For example, when motion is detected, an audible 

warning appears or other linkage actions happen. 

Click the  icon on the control panel, 

or click Tool->Event Management to open the Event Management page. 

 

 

You can set different linkage actions for the following triggers: 

Note: The event detection should be supported by the device before you can configure it. 

 Camera Event 

 Alarm Input 

 Device Exception 

Note: The event types of Camera Event vary according to different devices. Here we take the 

configuration of some event types as examples. For other types, please refer to the User Manual of 

the device. 

4.1 Configuring Motion Detection Alarm 

Purpose: 

A motion detection alarm is triggered when the client software detects motion within its defined area. 

The linkage actions, including alarm output, channel record and client action can be set. 

Note: The configuration varies according to different devices. For details, please refer to the User 

Manual of the devices. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 
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2. Select the camera to be configured and select Motion Detection as the event type. 

3. Check the checkbox Enable to enable the function of motion detection. Check the checkbox 

Enable Dynamic Analysis to mark the detected objects with green rectangles in live view and 

playback. 

4. Select the arming schedule template from the drop-down list. 

All-day Template: for all-day continuous arming. 

Weekday Template: for working-hours continuous arming from 8:00 AM to 8:00 PM. 

Template 01-09: fixed templates for special schedules. You can edit the templates if needed. 

Custom: can be customized as desired. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

5. Select the Configuration as desired. 

Note: For some camera, you can select Normal or Expert as the configuration type. Expert mode 

is mainly used to configure the sensitivity and proportion of object on area of each area for 

different day/night switch. For details, please refer to the User Manual of the device. 

6. Click-and-drag the mouse to draw a defined area for the arming region. 

You can click the icon  to set the whole video area as detection area, or click the icon  to 

clear all the detection area. 

7. Drag the slider on the sensitivity bar to adjust the motion detection sensitivity. The larger the 

value is, the more sensitive the detection is. 

8. Check the checkboxes to activate the linkage actions. For details, see Table 4.1 Linkage Actions for 

Motion Detection Alarm. 

9. Optionally, click Copy to… to copy the event parameters to other channels. 

10. Click Save to save the settings.  

 

Table 4. 1 Linkage Actions for Motion Detection Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Channel Record Start the recording of the selected cameras when alarm is triggered. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 
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Alarm Triggered 

Pop-up Image 

The image with alarm information pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 

 

Configuring Arming Schedule Template 

Perform the following steps to configure the arming schedule template: 

If Template 01-09 is selected in the drop-down list, start from step 1; 

If Custom is selected in the drop-down list, start from step 2. 

Steps: 

1. Click Edit to enter the Templates Management interface. Select the template to be set and you 

can edit the template name. 

2. Set the time schedule for the selected template. 

When the cursor turns to , you can set the time period. 

When the cursor turns to , you can move the selected time bar you just edited. You can 

also edit the displayed time point to set the accurate time period. 

When the cursor turns to , you can lengthen or shorten the selected time bar. 

3. Optionally, you can select the schedule time bar,  

and then click the icon  to delete the selected time bar, 

or click the icon  to delete all the time bars, 

or click the icon  to copy the time bar settings to the other dates. 

4. Click OK to save the settings. 

You can click Save as Schedule Template on the Custom Schedule interface, and then the custom 

template can be saved as template 01--09. 

Note: Up to 8 time periods can be set for each day in the arming schedule template. 
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4.2 Configuring Video Tampering Alarm 

Purpose: 

A video tampering alarm is triggered when the camera is covered and the monitoring area cannot be 

viewed. The linkage actions, including alarm output and client action can be set. 

Steps: 

1. Open the Event Management page and click the Camera Event tab. 

2. Select the camera to be configured and select Video Tampering Detection as the event type. 

3. Check the checkbox Enable to enable the function of video tampering. 

4. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

5. Select the triggered camera. The image or video from the triggered camera will pop up or be 

displayed on the Video Wall when tampering alarm occurs. 

6. Click-and-drag the mouse to draw a defined area for the arming region.  

You can click the icon  to set the whole video area as detection area, or click the icon  to 

clear the detection area.  

7. Drag the slider on the sensitivity bar to adjust the tampering alarm sensitivity.  

8. Check the checkboxes to activate the linkage actions. For details, see Table 4.2 Linkage Actions for 

Tampering Alarm. 

9. Optionally, click Copy to… to copy the event parameters to other cameras. 

10. Click Save to save the settings. 
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Table 4. 2 Linkage Actions for Tampering Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 

 

4.3 Configuring PIR Alarm 

Purpose: 

A PIR (Passive Infrared) alarm is triggered when an intruder moves within the detector's field of view. 

The heat energy dissipated by a person, or any other warm blooded creature such as dogs, cats, etc., 

can be detected.  

Note: The PIR Alarm function requires the support of connected device. 

Steps: 

1. Open the Event Management page and click the Camera Event tab. 

2. Select the camera to be configured and select PIR Alarm as the event type. 

3. Check the checkbox Enable to enable the function of PIR alarm. 

4. Input a descriptive name of the alarm. 

5. Check the checkboxes to activate the linkage actions. For details, see Table 4.3 Linkage Actions for 

PIR Alarm. 

6. Optionally, click Copy to… to copy the event parameters to other channels. 

7. Click Save to save the settings. 
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Table 4. 3 Linkage Actions for PIR Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Channel Record Start the recording of the selected cameras when alarm is triggered. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers. 

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image with alarm information pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 

 

4.4 Configuring Video Loss Alarm 

Purpose: 

When the client software cannot receive video signal from the front-end devices, the video loss alarm 

will be triggered. The linkage actions, including alarm output and client action can be set. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 

2. Select the camera to be configured and select Video Loss as the event type. 

3. Check the checkbox Enable to enable the function of video loss alarm. 

4. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

5. Select the triggered camera. The image or video from the triggered camera will pop up or be 

displayed on the Video Wall when video loss alarm occurs. 

6. Check the checkboxes to activate the linkage actions. For details, see Table 4.4 Linkage Actions for 

Video Loss Alarm. 
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7. Optionally, click Copy to… to copy the event parameters to other cameras. 

8. Click Save to save the new settings. 

 

 

Table 4. 4 Linkage Actions for Video Loss Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 

 

4.5 Configuring Audio Exception Alarm 

Purpose: 

The abnormal sounds, such as the silence detection, environment noise detection, and current noise 

detection, can be detected 

Enabling the Audio Input Detection can detects the exceptions of audio input condition. 

Enabling the Sudden Increase of Sound Intensity can detects the sudden increase of the sound 

intensity, and it consists of the following two settings. 

 Sensitivity: Range [1-100], the smaller the value the more severe the change should be to 

trigger the detection.  
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 Sound Intensity Threshold: Range [1-100], it can filter the sound in the environment, the 

louder the environment sound, the higher the value should be. You can adjust it according to 

the real environment.  

Enabling the Sudden Decrease of Sound Intensity can detects the sudden decrease of the sound 

intensity, by which you can find the abnormal silent. E.g.: The electric generator makes loud noise 

when it’s working, while it should be paid attention if the loud noise drops suddenly. 

You can set the sensitivity level [0~100] according to the actual environment. 

Note: The Audio Exception function requires the support of connected device. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 

2. Select the camera to be configured and select Audio Exception Detection as the event type. 

3. Check the related checkbox to enable the related function of audio detection alarm. 

4. Set the sensitivity and sound intensity threshold. 

5. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

6. Check the checkboxes to activate the linkage actions. For details, see Table 4.5 Linkage 

Actions for Audio Detection Alarm. 

7. Optionally, click Copy to… to copy the event parameters to other cameras. 

8. Click Save to save the new settings.  

 

Table 4. 5 Linkage Actions for Audio Detection Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Channel Record Start the recording of the selected cameras when alarm is triggered. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 
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Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 

 

4.6 Configuring Defocus Detection Alarm  

Purpose: 

The image blur caused by defocus of the lens can be detected and a series of alarm action can be 

triggered.  

Note: The Defocus Detection function requires the support of connected device. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 

2. Select the camera to be configured and select Defocus Detection as the event type. 

3. Check the checkbox Enable to enable the function of defocus detection alarm. 

4. Select the triggered camera. The image or video from the triggered camera will pop up or be 

displayed on the Video Wall when defocus alarm occurs. 

5. Check the checkboxes to activate the linkage actions. For details, see Table 4.6 Linkage 

Actions for Defocus Detection Alarm.  

6. Optionally, click Copy to… to copy the event parameters to other cameras. 

7. Click Save to save the new settings.  

 

Table 4. 6 Linkage Actions for Defocus Detection Alarm 

Linkage Actions Descriptions 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 



User Manual of iVMS-4200 

69 
 

 

4.7 Configuring Face Detection Alarm 

Purpose: 

The camera will detect human faces within the monitoring area automatically if the function is 

enabled. A series of alarm action will be triggered if the alarm is triggered. 

Note: The Face Detection function requires the support of connected device. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 

2. Select the camera to be configured and select Face Detection as the event type. 

3. Check the checkbox Enable to enable the function of face detection alarm. 

4. Set the sensitivity for face detection. 

5. Check the checkbox Enable Dynamic Analysis for Face Detection if you want the detected 

face get marked with rectangle in the live view. 

6. Check the checkboxes to activate the linkage actions. For details, see Table 4.7 Linkage 

Actions for Face Detection Alarm. 

7. Optionally, click Copy to… to copy the event parameters to other cameras. 

8. Click Save to save the new settings.  

 

Table 4. 7 Linkage Actions for Face Detection Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Channel Record Start the recording of the selected cameras when alarm is triggered. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 

Alarm Triggered Display the video on the Video Wall when alarm is triggered. 
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Video Wall Display Note: This option is only available when the decoding device is added. 

4.8 Configuring Line Crossing Detection 

Alarm 

Purpose: 

This function can be used for detecting people, vehicles and objects crossing a pre-defined virtual line. 

The crossing direction can be set as bidirectional, from left to right or from right to left. And a series 

of linkage method will be triggered if any object is detected. 

Note: This line crossing detection function requires the support of connected device. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 

2. Select the camera to be configured and select Line Crossing Detection as the event type. 

3. Check the checkbox Enable to enable the function. 

Note: For the specific speed dome, you can click Lock to prevent the speed dome from 

moving automatically during the configuration. 

4. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

5. Configure the arming region. 

Virtual Line ID: Click the drop-down list to choose an ID for the virtual line. 

Note: For some specific speed dome, you can click PTZ to move the speed dome to the 

desired scene which corresponds to a virtual line ID. In this way, you can configure the 

different line crossing detection alarms for multiple views. 

Virtual Line Direction: You can select the directions as A<->B, A ->B, and B->A. 

A<->B: When an object going across the line with both directions can be detected and 

alarms are triggered.  

A->B: Only the object crossing the virtual line from the A side to the B side can be 

detected.  

B->A: Only the object crossing the virtual line from the B side to the A side can be 

detected. 

6. Set the sensitivity [1~100]. 

7. Click  and draw a virtual line on the preview window. Optionally, you can click  and 

drag the virtual line to adjust its position, click  to delete the selected line. 

Note: Select another virtual line ID and draw another one. Up to 4 lines can be drawn. 

8. Check the checkboxes to activate the linkage actions. For details, see Table 4.8 Linkage 

Actions for Line Crossing Detection Alarm. 

9. Optionally, click Copy to… to copy the event parameters to other cameras. 

10. Click Save to save the settings. 
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Table 4. 8 Linkage Actions for Line Crossing Detection Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Channel Record Start the recording of the selected cameras when alarm is triggered. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 

 

4.9 Configuring Intrusion Detection Alarm 

You can set a detection area in the surveillance scene for Intrusion and once the area is been entered 

longer than the set time duration, a set of alarm action is triggered. 

Note: The Intrusion Detection function requires the support of connected device. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 

2. Select the camera to be configured and select Intrusion Detection as the event type. 

3. Check the checkbox Enable to enable the function of intrusion detection alarm. 

Note: For the specific speed dome, you can click Lock to prevent the speed dome from 

moving automatically during the configuration. 

4. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

5. Configure the arming region. 

Region ID: Click the drop-down list to choose a region ID for the arming region. 

Note: For some specific speed dome, you can click PTZ to move the speed dome to the 
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desired scene which corresponds to a region ID. In this way, you can configure the different 

Intrusion detection alarms for multiple views. 

Trigger Time Threshold: Range [0-10s], the threshold for the time of the object loitering 

in the region. If you set the value as 0, alarm is triggered immediately after the object 

entering the region. 

Percentage: Range [1-100]. Percentage defines the ratio of the in-region part of the 

object which can trigger the alarm. For example, when you set the percentage as 50%, 

half of the object entering the region will trigger the alarm. 

Sensitivity: Range [1-100]. The value of the sensitivity defines the size of the object 

which can trigger the alarm, when the sensitivity is high, a very small object can trigger 

the alarm. 

6. Click  and draw a quadrangle on the preview window. Optionally, you can click  and 

drag the virtual line to adjust its position, or click  to delete the selected region. 

Notes: 

 When you draw the quadrangle, click on the preview window to set the vertex to set 

the quadrangle.  

 Select another virtual line ID and draw another one. Up to 4 lines can be drawn. 

7. Check the checkboxes to activate the linkage actions. For details, see Table 4.9 Linkage 

Actions for Intrusion Alarm. 

8. Optionally, click Copy to… to copy the event parameters to other cameras. 

9. Click Save to save the new settings.  

 

Table 4. 9 Linkage Actions for Intrusion Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Channel Record Start the recording of the selected cameras when alarm is triggered. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 
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Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 

 

4.10 Configuring Scene Change Alarm 

Purpose: 

Scene change detection is used to detect the change of surveillance environment affected by the 

external factors; such as the intentional rotation of the camera. 

Note: The Scene Detection function requires the support of connected device. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 

2. Select the camera to be configured and select Scene Detection as the event type. 

3. Check the checkbox Enable to enable the function of audio detection alarm. 

Sensitivity: Range [1-100]. The higher the sensitivity, the easier the change of scene can 

trigger the alarm.  

4. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

5. Check the checkboxes to activate the linkage actions. For details, see Table 4.10 Linkage 

Actions for Scene Change Alarm. 

6. Optionally, click Copy to… to copy the event parameters to other cameras. 

7. Click Save to save the new settings. 

 

Table 4. 10 Linkage Actions for Scene Change Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Channel Record Start the recording of the selected cameras when alarm is triggered. 

Audible Warning The client software gives an audible warning when alarm is triggered. 
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Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 

 

4.11 Configuring VCA Detection Alarm 

Purpose: 

When the VCA alarm of the connected device occurs, a series of linkage actions can be triggered. 

Note: The VCA Detection function requires the support of connected device. 

Steps: 

1. Open the Event Management page and click Camera Event tab. 

2. Select the camera to be configured and select VCA Detection as the event type. 

3. Check the checkbox Enable to enable the function of VCA Detection alarm. 

4. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

5. Check the checkboxes to activate the linkage actions. For details, see Table 4.11 Linkage 

Actions for VCA Detection Alarm. 

6. Optionally, click Copy to… to copy the event parameters to other cameras. 

7. Click Save to save the new settings. 

 

Table 4. 11 Linkage Actions for VCA Detection Alarm 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Channel Record Start the recording of the selected cameras when alarm is triggered. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  
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Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image of the triggered camera pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 

 

4.12 Configuring Alarm Input Linkage 

Purpose: 

When a device's alarm input port receives a signal from an external alarm device, such as smoke 

detector, doorbell, etc., the alarm input linkage actions are triggered for notification. 

Before you start: 

Add the alarm inputs to the client, click Import on the Group Management interface, click the Alarm 

Input tab and import alarm inputs into groups for management. 

Steps: 

1. Open the Event Management page and click the Alarm Input tab. 

2. Select the alarm input channel to be configured. 

3. Check the checkbox Enable. 

4. Input a descriptive name of the alarm. 

5. Set the alarm status according to the alarm input device. 

6. Select the arming schedule template from the drop-down list.  

If you need to edit or customize the template, see Configuring Arming Schedule Template. 

7. Check the checkboxes to activate the linkage actions. For details, see Table 4.12 Linkage Actions 

for Alarm Input. 

8. Optionally, click Copy to… to copy the event parameters to other alarm inputs. 

9. Click Save to save the settings. 

 

Table 4. 12 Linkage Actions for Alarm Input 

Linkage Actions Descriptions 

Alarm Output Enable the alarm output function. Select the alarm output port and the 
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external device connected to the port can be controlled. 

Channel Record Start the recording of the selected cameras when alarm is triggered. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

Alarm on E-map Display the alarm information on the E-map. 

Alarm Triggered 

Pop-up Image 

The image with alarm information pops up when alarm is triggered. 

Alarm Triggered 

Video Wall Display 

Display the video on the Video Wall when alarm is triggered. 

Note: This option is only available when the decoding device is added. 

 

4.13 Configuring Device Exception Linkage 

Steps: 

1. Open the Event Management page and click the Device Exception tab. 

2. Select the device to be configured. 

3. Select the device exception type, including HDD full, HDD exception, illegal login, etc. 

4. Check the checkbox Enable. 

5. Check the checkboxes to activate the linkage actions. For details, see Table 4.13 Linkage Actions 

for Device Exception. 

6. Optionally, click Copy to… to copy the event parameters to other devices. 

7. Click Save to save the settings. 

 

Table 4. 13 Linkage Actions for Device Exception 

Linkage Actions Descriptions 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Audible Warning The client software gives an audible warning when alarm is triggered. 

Email Linkage Send an Email notification of the alarm information to one or more receivers.  

 



User Manual of iVMS-4200 

77 
 

4.14 Viewing Alarm and Event Information  

The information of recent alarms and events can be displayed. Click the icon  in Alarms and Events 

Toolbar to show the Alarms and Events panel. Or click  to display the Alarm Event interface. 

 

 

 

Note: Before you can receive the alarm information from the device, you need to click Tool->Device 

Arming Control and arm the device by checking the corresponding checkbox. 

 
 

On the Alarms and Events panel, the following toolbar buttons are available: 

 Clear Info Clear the information of alarms and events displayed on the list. 

  
Enable/Disable Alarm 

Triggered Pop-up Image 
Click to enable/disable image pop-up when alarms occur. 

  Enable/Disable Audio Click to enable/disable the audio warning for the alarm. 
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  Auto Hide/Lock Click to hide automatically/lock the Alarms and Events panel. 

 Maximize Maximize the Alarms and Events panel in a new tab page. 

  Show/Hide Click to show/hide the Alarms and Events panel. 

 

Viewing Alarms Information 

Different alarm types can be displayed on the panel: Motion Detection, Video/Audio Exception, Alarm 

Input, Device Exception, VCA Alarm and Other Alarm. You can check the checkbox to enable the 

displaying of that type alarm. 

Before you start: 

To display the alarms, the event parameters need to be configured. 

Steps: 

1. Click the Alarm tab. 

2. Check the checkboxes of different alarm types. 

3. When an alarm occurs, the icon  twinkles to call attention. The alarm information, including 

the time, source, details and content will be displayed.  

Click  to get a live view of the alarm triggered camera. The instant playback that is 30s before 

the alarm (if available) will start in the left window before playing the live video. In the right 

window, the alarm picture displays. 

Note: The Picture Storage should be checked for storing the alarm pictures of the camera on the 

storage server. You can click Configure to set the parameters. For details, please refer to Section 

3.1.2 Storing on Storage Device. 

 

Click  to send an Email notification of the alarm to one or more receivers if the email settings 

are properly configured (Section 10.2.6 Email Settings). 

Click  to display the video of alarm triggered camera on the Video Wall. You can enter the 

Video Wall interface to check the alarm triggered video playing on the screen which set as the 

alarm window. The physical video wall also displays the video. 

Note: You should add decoding device and configure the video wall. For details, please refer to 

Chapter 12 Decoding and Displaying Video on Video Wall. 

Click under the Note column to input the description for the alarm. 

4. To clear the alarm information, click the icon , or right-click on an alarm log and then click 

Clear. 

Viewing Events Information 
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Purpose: 

The abnormal events of the client software, such as the live view failure, device disconnection, can 

also be displayed. 

Steps: 

1. Click the Event tab.  

The event information, including the time and detailed description will be displayed. 

2. To clear the event information, click the icon , or right-click on the event log and then click 

Clear. 

 

 

  



User Manual of iVMS-4200 

80 
 

Chapter 5  E-map Management 

Purpose: 

The E-map function gives a visual overview of the locations and distributions of the installed cameras 

and alarm input devices. You can get the live view of the cameras on the map, and you will get a 

notification message from the map when alarm is triggered. 

Click the  icon on the control panel, 

or click View->E-map to open the E-map page. 

 

 

E-map Page 

1 Group List 

2 Map Display Area 

3 E-map Toolbar 

5.1 Adding an E-map 

Purpose: 

An E-map needs to be added as the parent map for the hot spots and hot regions. 

Steps: 

1. Open the E-map page. 

2. Select a group for which you want to add a map. 

3. Click the icon  in the Map Display Area to open the map adding dialog box. 

4. Input a descriptive name of the added map as desired. 

5. Click the icon  and select a map file from the local path.  

6. Click OK to save the settings. 

Notes:  

 The picture format of the map can only be *.png, *.jpg or *.bmp. 
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 Only one map can be added to a group. 

 
 

The map added is displayed in the Map Display Area. Use the mouse wheel or click  or , to 

zoom in or zoom out on the map. You can click-and-drag the yellow window in the lower-right corner 

or use the direction buttons and zoom bar to adjust the map area for view. 

 

 

Click the button Edit Map or Map Preview in the E-map toolbar to enter the map editing mode or 

map preview mode. 

E-map Toolbar in Map Editing Mode: 

 
E-map Toolbar in Map Preview Mode: 

 

 

On the E-map page, the following toolbar buttons are available: 

 Modify Map Modify the map information, including the map name and file path. 

 Delete Map Delete the current map. 

 Add Camera Add a camera as the hot spot on the map. 

 Add Alarm Input Add an alarm input sensor as the hot spot on the map. 

 Add Hot Region Add a map as the hot region on the current map. 

 Modify Modify the information of the selected hot spot or hot region. 
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 Delete Delete the selected hot spot or hot region. 

 Clear Alarm Info Clear the alarm information displayed on the map. 

 
Back to Parent 

Map 
Go back to the parent map. 

 

5.2 The Hot Spot Function 

Purpose: 

The cameras and alarm inputs can be added on the map and are called the hot spots. The hot spots 

show the locations of the cameras and alarm inputs, and you can also get the live view and alarm 

information of the surveillance scenarios through the hot spots. 

5.2.1 Adding Hot Spots 

Adding Cameras as Hot Spots 

Steps: 

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode. 

2. Click the icon  in the toolbar to open the Add Hot Spot dialog box. 

3. Check the checkboxes to select the cameras to be added. 

4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon by 

double-clicking the corresponding field. 

5. Click OK to save the settings. The camera icons are added on the map as hot spots and the icons 

of added cameras changes from  to  in the group list. You can click-and-drag the camera 

icons to move the hot spots to the desired locations. 

You can also click-and-drag the camera icons from the group list to the map directly to add the 

hot spots. 

 

 

Adding Alarm Inputs as Hot Spots 

Steps: 
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1. Click the Edit Map button in the E-map toolbar to enter the map editing mode. 

2. Click the icon  in the toolbar to open the Add Hot Spot dialog box. 

3. Check the checkboxes to select the alarm inputs to be added. 

4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon by 

double-clicking the corresponding field. 

5. Click OK to save the settings. The alarm input icons are added on the map as hot spots and the 

icons of added alarm inputs changes from  to   in the group list. You can click-and-drag 

the alarm input icons to move the hot spots to the desired locations. 

You can also click-and-drag the alarm input icons from the alarm input list to the map directly to 

add the hot spot. 

 

5.2.2 Modifying Hot Spots 

Purpose: 

You can modify the information of the added hot spots on the map, including the name, the color, the 

icon, etc. 

Steps: 

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode. 

2. Select the hot spot icon on the map and then click  in the toolbar, right-click the hot 

spot icon and select Modify, or double-click the hot spot icon on the map to open the Modify Hot 

Spot dialog box. 

3. You can edit the hot spot name in the text field and select the color, the icon and the linked 

camera or alarm input. 

4. Click OK to save the new settings. 

To delete the hot spot, select the hot spot icon and click  in the toolbar, or right-click the hot 

spot icon and select Delete. 
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5.2.3 Previewing Hot Spots 

Steps: 

1. Click the Map Preview button in the E-map toolbar to enter the map preview mode. 

2. Double-click the camera hot spots or right-click it and select Live View, and you can get the live 

view of the cameras.  

3. If there is any alarm triggered, an icon  will appear and twinkle near the hot spot. Click the 

alarm icon, and then you can check the alarm information, including alarm type and triggering 

time. 

Note: To display the alarm information on the map, the Alarm on E-map functionality needs to be set 

as the alarm linkage action. For details, refer to Chapter 4 Event Management. 

 

 

5.3 The Hot Region Function 

Purpose: 
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The hot region function links a map to another map. When you add a map to another map as a hot 

region, an icon of the link to the added map is shown on the main map. The added map is called child 

map while the map to which you add the hot region is the parent map. 

Note: A map can only be added as the hot region for one time. 

5.3.1 Adding Hot Regions 

Before you start: 

Add a map to another group. 

Steps: 

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode. 

2. Select an added map as the parent map. 

3. Click the icon  in the toolbar to open the Add Hot Region dialog box. 

4. Check the checkbox to select the child map to be linked. 

5. Optionally, you can edit the hot region name, and select the hot region color and icon by 

double-clicking the corresponding field. 

6. Click OK to save the settings. The child map icons are added on the parent map as the hot regions. 

You can click-and-drag the child map icons to move the hot regions to the desired locations. 

 

 

5.3.2 Modifying Hot Regions 

Purpose: 

You can modify the information of the hot regions on the parent map, including the name, the color, 

the icon, etc. 

Steps: 

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode. 

2. Select the hot region icon on the parent map and then click  in the toolbar, right-click the hot 

spot icon and select Modify, or double-click the hot region icon to open the Modify Hot Region 

dialog box.  

3. You can edit the hot region name in the text field and select the color, the icon and the linked 

child map. 



User Manual of iVMS-4200 

86 
 

4. Click OK to save the new settings. 

To delete the hot region, select the hot region icon and click  in the toolbar, or right-click the 

hot spot icon and select Delete. 

 

 

5.3.3 Previewing Hot Regions 

Steps: 

1. Click the Map Preview button in the E-map toolbar to enter the map preview mode. 

2. Click the hot region icon to go to the linked child map. 

3. The hot spots can also be added on the hot regions. 

4. You can click the icon  in the toolbar to go back to the parent map.  

You can also click the icon  in the toolbar to clear the alarm information. 
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Chapter 6  EZVIZ Cloud P2P 

Purpose: 

The client software also supports to register an EZVIZ Cloud P2P account, log into your EZVIZ Cloud 

P2P and manage the devices which support the EZVIZ Cloud P2P service. 

6.1 Registering an EZVIZ Cloud P2P Account 

Purpose: 

If you do not have an EZVIZ Cloud P2P account, you can register one. 

Steps: 

1. Open the Device Management page and click the Server tab. 

2. Click Add New Device Type, select EZVIZ Cloud P2P Device and click OK. 

3. Click EZVIZ Cloud P2P Device on the list and then click Register. 

  
4. Enter the required information to register an account. 

EZVIZ Cloud P2P Account: Edit a user name for your account as desired. 

Password and Confirm: Enter the password for your account and confirm it. 

Email: Enter your email account to register the account. 

Verification Code: Enter the verification code shown in the picture. If it is not clear, you can click 

Refresh to get a new one. 

Email Verification Code: Click Get Verification Code and enter the verification code received by 

your email.  

 

 For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product.  

 Proper configuration of all passwords and other security settings is the responsibility of the 

installer and/or end-user. 

5. Click Register to get an EZVIZ Cloud P2P account. 
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6.2 Logging into EZVIZ Cloud P2P Account 

Steps: 

1. Click Login and enter the EZVIZ Cloud P2P account and password. 

2. Click Login to log into your account. 

Note: 

If you forget your password, click Forgot Password to verify your account and reset your 

password. 

EZVIZ Cloud P2P Account: Edit user name of your account. 

Verification Code: Enter the verification code shown in the picture. If it is not clear, you can click 

Refresh to get a new one. 

Email Verification Code: Click Get Verification Code and enter the verification code received by 

your email. 

Password and Confirm: Click Next and enter a new password for your account and confirm it. 

  

 

 For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product.  

 Proper configuration of all passwords and other security settings is the responsibility of the 

installer and/or end-user. 

3. After login, you can click Login to switch to another account or click Logout to log out of your 

EZVIZ Cloud P2P account. 

 

6.3 Device Management 

Steps: 

1. Click Add Device and input the serial No. and verification code of the device. 

Notes: 

 Only the device that supports the EZVIZ Cloud P2P service can be added. 

 The serial No. and the verification code is marked on the label of you device. 

 The device can only be added to one EZVIZ Cloud P2P account. 
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2. Click OK to add the device and the successfully added device will list on the device management 

interface. 

Note: A group named as your account name is created by default, you can import the cameras of 

the added devices to the default group or other groups. For group management, please refer to 

Section 2.3 Group Management. 

3. For live view, please refer to Section 2.4 Basic Operations in Live View; for playback, please refer 

to Section 3.2 Remote Playback; for e-map settings, please refer to Chapter 5 E-map 

Management. 

4. Click to select a device and click Config to pop up the remote configuration interface of the 

device. You can do some remote configurations for the device. For detailed settings about the 

remote configuration, please refer to the User Manual of the device. 

Note: This function should be suported by the device. 

5. If you want delete the device, select the device(s) and click Delete Device. You can also enter the 

keyword of the device name in the Filter field to filter the required devices. 
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Chapter 7  VCA Devices Management 

Purpose: 

The VCA (Video Content Analysis) devices can be added to the client for VCA configuration, including 

VCA resource allocation, rule settings, VQD (Video Quality Diagnostics), etc. 

 

Allocating VCA Resource 

Before you start: You should add the VCA device to the software. Please refer to Section 2.2 Adding 

the Device for adding the VCA device as Encoding Device. 

Purpose: Before you can set the VCA configuration for the added device, you need to configure the 

VCA resource of the device which means to enable the VCA function of the corresponding cameras. 

Option 1 

Steps: 

1. In the Device Management Configuration interface, select Server tab. 

2. Click to select the VCA device and click VCA Allocation to activate the VCA Resource Allocation 

window. 

In the Resource Information area, you can view the VCA type and VCA resource usage of the 

device. 

Example: In the figure shown below, the VCA type of the device is Behavior Analysis and a 

camera is available for configuring VCA settings. And the camera has been enabled with VCA 

function. 

 

3. In the VCA Resource Allocation panel, check  checkbox to enable the VCA function of the 

camera. Or you can uncheck  checkbox to disable the VCA function. 

4. Click Done to save the settings and click  to exit. 

Option 2 

Steps: 

1. In the Device Management Configuration interface, select Group tab. 

Note: Before you can set the VCA configuration for the device, you should configure the group 

settings for it. For details, please refer to Section 2.3 Group Management. 

2. Select a camera of the VCA device for configuration and click VCA Config to enter the VCA 

Configuration interface. If no camera of the device has been configured with VCA function, the 

following window pops up. 
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Note: If the camera has been configured with VCA function, the VCA information page displays. 

 

3. In the VCA Resource Allocation panel, check  checkbox to enable the VCA function of the 

camera. Or you can uncheck  checkbox to disable the VCA function. 

4. Click Done to save the settings and you will enter the VCA information page. 

 

Configuring VCA Settings 

After allocating the VCA resource, you can configure the VCA settings for the camera. 

Steps: 

1. In the Device Management Configuration interface, select Group tab. 

Note: Before you can set the VCA configuration for the device, you should configure the group 

settings for it. For details, please refer to Section 2.3 Group Management. 

2. Select a camera of the VCA device for configuration and click VCA Config to enter the VCA 

Configuration interface. 

Note: The interface varies according to different VCA devices. 

The corresponding parameters and related configuration steps are shown on the Instruction panel. 

You can set the VCA configuration for the camera according to the provided instruction. 

Click Enable Wizard and the wizard will guide you to set the quick VCA configuration for the camera. 
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Chapter 8  Transcoder Management 

Purpose: 

Transcoder is designed for real-time transcoding of different streams. With the use of transcoder, 

streams and control signals from different manufactures and different surveillance systems can be 

effectively integrated and standardized. iVMS-4200 client software supports to add transcoder and 

configure the transcoding function for it. 

8.1 Adding Encoding Device to the Transcoder 

8.1.1 Adding the Transcoder to the Client Software 

Steps: 

1. Click the on the control panel to enter the Device Management interface and click the 

Server tab. 

 

2. Click Add New Device Type on the Organization list and select Transcoder. 

3. Click OK to save the settings, and the added transcoder type is displayed on the Organization list. 

 

4. Click Transcoder and click Add Device to add the transcoder to the management list of the 
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software. 

 

Select the adding mode by IP/Domain or by IP segment, and configure the corresponding settings 

for the device. 

For the detailed configuration about the adding modes, please refer to the following sections: 

 By specifying the device IP/Domain address, see Section 2.2.3 Adding Devices Manually. 

 By specifying an IP segment, see Section 2.2.4 Adding Devices by IP Segment. 

5. The successfully added transcoder can be viewed in the list: 

 

8.1.2 Importing the Encoding Channel to the Transcoder  

Before you start: 

The cameras of encoding devices should be organized into groups before being imported to the 

transcoder. For detailed configuration, please refer to Section 2.3 Group Management. 

Steps:  

1. On the Device Management interface, select a transcoder from the device list and click Settings to 

enter the transcoder settings interface.  

2. Select a group or a camera from the Group list and click the Import button to import the selected 

camera or the cameras of the group, or click Import All to import the cameras of all groups to the 

transcoder on the right. 

3. Optionally, you can click to select the stream and click  to remove it from the transcoding list. 
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8.2 Configuring the Transcoded Stream 

Parameters 

Steps: 

1. On the Transcoder Settings interface, select a stream from the list and you can configure its 

parameters in the Selected Transcoded Stream area.  

 

2. Configure the parameters of the transcoded stream as needed, including the resolution, bitrate, 

package format, video encoding type, protocol type and video stream from the drop-down list. 

3. (Optional) Check the checkbox of Obtain Video Stream Via Stream Media Server if you want to 

use the stream media server to forward the video stream. 

Note: You should add a stream media server to the client before you can select the stream media 

server. 

4. Click Advanced Settings to enter the advanced settings of the selected transcoded stream.  

(1) Edit the parameters of the transcoded stream on demands, including the stream type, video 

quality, bitrate type, frame rate, frame type, audio encoding type, profile and I frame interval.  

You can also remain the default parameters of the stream.  
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(2) Click OK to save the settings.  

5. (Optional) Click the Copy to on the Selected Transcoded Stream settings area to copy the settings 

of the current stream to other stream(s). 

 

6. Click Save to save the settings.  

8.3 Operating the Transcoded Stream 

Purpose: 

After successfully transcoding, the live view of the camera uses transcoded stream. 

Steps: 

1. Enter the Main View interface and select a transcoded camera for live view. For detailed 

configuration, please refer to Section 2.4 Basic Operations in Live View. 

Note: If the camera is in live view before transcoding, please stop the live view first and then start 

the live view again to view the live video of the camera via transcoded stream. 

2. During the live view, you can right-click on the camera node and select Transcoding Status to view 

the transcoding status. 

 
3. For e-map settings, please refer to Chapter 5 E-map Management; for displaying on video wall, 

please refer to Chapter 12 Decoding and Displaying Video on Video Wall. 

Note: Displaying the transcoded stream on video wall should be supported by the decoder.  
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Chapter 9  Log Management 

Purpose: 

The log files of the client software are stored on the local PC and can be searched for checking. 2 types 

of log files are provided: client logs and server logs. The client logs refer to the log files of the client 

and are stored on the local PC; the server logs refer to the log files of the connected devices and are 

stored on the local device. 

Click the  icon on the control panel to open the Log Search page. 

 

Searching Log Files 

Steps: 

1. Open the Log Search page. 

2. Select the log type. If Server Logs is selected, then click to specify the device for search. 

3. Click the icon  to specify the start time and end time. 

4. Click Search. The log files between the start time and end time will be displayed on the list. 

You can check the operation time, type and other information of the logs. 

Note: Please narrow the time range or filter the log type for search if there are too many log files. 
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Filtering Log Files 

Purpose: 

After searched out successfully, the log files can be filtered by the keyword or condition, and thus you 

can find the logs as you want. 

Steps: 

1. Click Log Filter or the icon  on the Log Search page to expand the Log Filter panel. 

2. Select Filter by Keyword, and then input keyword for filtering in the text field; or 

select Filter by Condition, and then specify log type in the drop-down list. 

3. Optionally, you can click More… to filter the log files more accurately. 

4. Click Filter to start filtering. You can click Clear Filter the cancel the filtering. 

 

 

 

Backing up Log Files 

Purpose: 

The log files, including the client logs and server logs, can be exported for backup. 

Steps: 

1. Set the condition and search the log file. 

2. Click Backup Log to open the Backup Log dialog box. 

3. Click the icon , select a local saving path and set a name for the file. 

4. Click Backup to export the selected log file for backup. 

You can click FileOpen Log File to check the information of the backup log files on local PC. 
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Chapter 10  Account Management and 

System Configuration 

10.1 Account Management 

Purpose: 

Multiple user accounts can be added to the client software, and you are allowed to assign different 

permissions for different users if needed. 

Click the  icon on the control panel, 

or click Tool->Account Management to open the Account Management page. 

 

 

Note: The user account you registered to log into the software is set as the super user. 

Adding the User 

Steps: 

1. Open the Account Management page. 

2. Click Add User to open the Add User dialog box. 

3. Select the user type from the drop-down list. 2 types of user accounts are selectable: 

Administrator: The administrator account has all permissions by default, and can modify the 

passwords and permissions of all operators and its own account. 

Operator: The operator account has no permission by default and you can assign the permissions 

manually. An operator can only modify the password of its own account. 

4. Input the user name, password and confirm password as desired. 

5. Check the checkboxes to assign the permissions for the created user. Optionally, you can select a 

user in the Copy from drop-down list, to copy the permissions of the selected user. 

6. Optionally, you can click Default Permission to restore the default permissions of this user. 
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7. Click Save to save the settings.  

 

 A user name cannot contain any of the following characters: / \ : * ? “ < > |. And the length of 

the password cannot be less than 6 characters. 

 For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product.  

 Proper configuration of all passwords and other security settings is the responsibility of the 

installer and/or end-user. 

Note: Up to 50 user accounts can be added for the client software. 

 

 

Managing the User 

Purpose: 

After created successfully, the user account is added to the user list on the Account Management page. 

You can edit or delete the information of the user accounts. 

To edit the information of the user, select the user from the list, and click Edit User. 

To delete the information of the user, select the user from the list, and click Delete User. 

For super and administrator user, you can click Copy to to copy the permissions to other user(s). 

Note: The super user cannot be deleted and only the password of the super user can be edited. 

10.2 System Configuration 

Purpose: 

The general parameters, file saving paths, keyboard and joystick shortcuts, alarm sounds and Email 

settings can be configured. 

Click the  icon on the control panel, 
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or click Tool->System Configuration to open the System Configuration page. 

 

 

Note: You can click Default Value to restore the defaults of all the system configurations. 

10.2.1 General Settings 

Purpose: 

The frequently-used parameters, including the log expired time, view scale, etc., can be set. 

Steps: 

1. Open the System Configuration page. 

2. Click the General tab to enter the General Settings interface. 

3. Configure the general parameters. For details, see Table 10.1 General Parameters. 

4. Click Save to save the settings. 

 
 

Table 10.1 General Parameters 

Parameters Descriptions 

Log Expiry Date The time for keeping the log files, once exceeded, the files will be deleted. 

Network Performance The current network conditions. It can be set as Normal, Better or Best. 
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Picture Format Set the file format for the captured pictures during live view or playback. 

Maximum Mode 

Select Maximize or Full Screen as the maximum mode. For selecting 

Maximize, the software will be maximized and the taskbar will display. For 

selecting Full Screen, the software will be displayed in full-screen mode. 

Enable Web Service 

Enable this function to allow to access iVMS-4200 client software via web 

browser. You can also set the web server port as desired. By default, it is 

80. If the port No. of your PC running the iVMS-4200 is occupied, you can 

change it to other value. 

After changing the port No., you should access the client via web browser 

by inputting IP address of the PC running the client : new port No.. Please 

refer to Section 18.1 Login for details. 

Enable Screen Toolbar 

Display 

Show the toolbar on each display window in live view or playback. 

Enable Auto-login Log into the client software automatically. 

Prioritize Playback of 

Record Files on Storage 

Server 

Play back the video files recorded on the storage server preferentially.  

Otherwise, play back the video files recorded on the local device. 

Resume Live View 

Status 

Resume the latest live view status after you log into the client again. 

Disconnect Background 

Videos in Single Live 

View  

In multiple-window division mode, double-click a live video to display it in 

1-window division mode, and the other live videos will be stopped for 

saving the resource. 

Pop up Security Prompt 

When Using Default 

Password 

If the default password of the added device has not been changed, the 

prompt will pop up for notification. 

Enable Wheel for Zoom 

Enable to use the mouse wheel for zoom in or out of the video in PTZ 

mode, or for zoom in or restoring of the video in digital zoom mode. In this 

way, you can directly zoom in or out (or restore) the live video by scrolling 

the mouse. 

Auto Time Adjustment Adjust the time automatically at a specified time point. 

 

10.2.2 Image Settings 

Purpose: 

The image parameters of the software can be configured, such as view scale, play performance, etc. 

Steps: 

1. Open the System Configuration page. 

2. Click the Image tab to enter the Image Settings interface. 

3. Configure the image parameters. For details, see Table 10.2 Image Parameters. 

4. Click Save to save the settings. 
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Table 10.2 Image Parameters 

Parameters Descriptions 

View Scale 
The view scale of the video in live view or playback. It can be set as Full 

Screen, 4:3, 16:9 or Original Resolution. 

Play Performance 
The play performance of the live video. It can be set as Shortest Delay or 

Self-adaptive. 

Auto-change Video 

Stream 

Change the video stream (main stream or sub-stream) automatically in live 

view according to the size of the display window.  

Enable Highlight 
Mark the detected objects with green rectangles in live view and 

playback. 

Display Transaction 

Information 

Display the transaction information in the live view. 

VCA Rule Display the VCA rule in the live view. 

10.2.3 File Saving Path Settings 

Purpose: 

The video files from manual recording, the captured pictures and the system configuration files are 

stored on the local PC. The saving paths of these files can be set. 

Steps: 

1. Open the System Configuration page. 

2. Click the File tab to enter the File Saving Path Settings interface. 

3. Click the icon  and select a local path for the files. 

4. Click Save to save the settings. 
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10.2.4 Keyboard and Joystick Shortcuts Settings 

Purpose: 

The keyboard can be connected to the client and be used to control the PTZ cameras. You can set the 

shortcuts for keyboard and joystick to get quick and convenient access to the commonly used actions. 

Steps: 

1. For keyboard: Select the COM port from the drop-down list if the keyboard is connected to the PC 

installed with the client. 

2. For keyboard and joystick: 

1) Select a certain function from the list. 

2) Double-click the item field under the PC Keyboard, USB Joystick or USB Keyboard column. 

3) Select the compound keys operation or number from the drop-down list to set it as the 

shortcuts for the function of the keyboard or USB joystick. 

3. Click Save to save the settings. 

 

10.2.5 Alarm Sound Settings 

Purpose: 

When the alarm, such as motion detection alarm, video exception alarm, etc., is triggered, the client 

can be set to give an audible warning and the sound of the audible warning can be configured. 

Steps: 

1. Open the System Configuration page. 

2. Click the Alarm Sound tab to enter the Alarm Sound Settings interface. 

3. Click the icon  and select the audio files from the local path for different alarms. 

4. Optionally, you can click the icon  for a testing of the audio file. 

5. Click Save to save the settings. 

Note: The format of the audio file can only be *wav. 
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10.2.6 Email Settings 

Purpose: 

An Email notification can be sent when a system alarm occurs. To send the Email to some specified 

receivers, the settings of the Email need to be configured before proceeding. 

Steps: 

1. Open the System Configuration page. 

2. Click the Email tab to enter the Email Settings interface. 

3. Input the required information. 

Server Authentication (Optional): If your email server requires authentication, check this 

checkbox to use authentication to log into the server and enter the login user name and 

password of your email account. 

SMTP Server: Input the SMTP Server address. 

Port: Input the communication port of Email service. The port is 25 by default. 

User Name: Input the user name of the sender Email address if Server Authentication is checked. 

Password: Input the password of the sender Email address if Server Authentication is checked. 

Sender Address: Input the Email address of the sender. 

Receiver 1—3: Input the Email address of the receiver. Up to 3 receivers can be set. 

4. Optionally, you can check the checkbox Enable SSL to increase the security of email sending. 

5. Optionally, you can click Send Test Email to send an email to the receiver for test. 

6. Click Save to save the settings. 
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Chapter 11  Forwarding Video Stream 

through Stream Media Server 

Purpose: 

There is always a limit of the device remote access number. When there are many users wanting to get 

remote access to the device to get the live view, you can add the stream media server and get the 

video data stream from the stream media server, thus to lower the load of the device. 

11.1 Adding the Stream Media Server 

Before you start: 

The stream media server application software needs to be installed and it is packed in the iVMS-4200 

software package. When installing the iVMS-4200, check the checkbox Stream Media Server to 

enable the installation of stream media server. 

Steps: 

1. Click the shortcut icon  on the desktop to run the stream media server. 

Note: You can also forward the video through the stream media server installed on other PC. 

2. Open the Device Management page and click the Server tab. 

3. Click Add New Device Type, select Stream Media Server and click OK. 

4. Click Stream Media Server on the list and then click Add Device. 

You can add the stream media server in the following two ways: 

 Adding Stream Media Server by IP Address 

Perform the following steps to add the stream media server: 

1) Select IP Address as the adding mode. 

2) Input the nickname and IP address of the stream media server. The default port value is 

554. 

3) Click Add to add the stream media server to the client software. 

 

 

 Adding Stream Media Server by IP Segment 

Perform the following steps to add the stream media server by IP segment: 

1) Select IP Segment as the adding mode. 

2) Input the start IP and end IP. The default port value is 554. 

3) Click Add to add the stream media server to the client software. The stream media 
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server of which the IP address is between the start IP and end IP will be added to the 

client. 

 

 

Note: For one client, up to 16 stream media servers can be added. 

11.2 Adding Cameras to Stream Media Server to 

Forward Video Stream  

Purpose: 

To get the video stream of a camera via stream media server, you need to connect the camera to the 

stream media server. 

Steps: 

1. Select the stream media server from the list.  

2. Click Configure to enter the Stream Media Server Settings interface. 

3. Select the cameras of which the video stream is to be forwarded via the stream media server. 

4. Click OK to save the new settings. 

5. Go the Main View page and start the live view of the cameras again. You can check the channel 

number of the video stream forwarded through or sent from the stream media server. 

Note: For one stream media server, up to 64 channels of video stream can be forwarded through it 

and up to 200 channels of video stream can be sent to clients from it. 
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Chapter 12  Decoding and Displaying 

Video on Video Wall 

The Video Wall module provides the video decoding functionality, and the decoded video can be 

displayed on the Video Wall for an attention-grabbing performance. 

Note: The Video Wall module only displays when Decoding Device is enabled for adding to the client. 

Steps: 

1) Enter the Device Management page and click the Server tab.  

2) Click Add New Device Type, select Decoding Device and click OK. Then the  module will 

display on the control panel. 

Click the  icon on the control panel, or click View->Video Wall to open the Video Wall page. 

 

 

12.1 Adding the Encoding Device 

Purpose: 

You should add the encoding device for decoding and displaying on the video wall. If you do not add 

the encoding devices in the Device Management page, you can add them in Video Wall page. 

Steps: 

1. In the Camera area, click  to activate the adding device window. 
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2. Select the adding mode and configure the corresponding settings for the device. 

For the detailed configuration about the 4 adding modes, please refer to the following sections: 

 By specifying the device IP address, see Section 2.2.3 Adding Devices Manually. 

 By specifying an IP segment, see Section 2.2.4 Adding Devices by IP Segment. 

 By IP Server, see Section 2.2.5 Adding Devices by IP Server. 

 By HiDDNS, see Section 2.2.6 Adding Devices by HiDDNS. 

(Optional) If you want to add the third-party encoding device, please perform the following steps: 

1. Go to the Device Management page and click the Server tab.  

2. Click Add New Device Type, select Third-party Encoding Device and click OK.  

3. Select Third-party Encoding Device in the organization panel and click Add Device to activate the 

Add Device window.  

 For IP/Domain: Edit the nickname, IP address / domain name, port No., user name, 

password, channel number, start from and manufacturer for the device.  

 For IP Segment: Edit the start IP, end IP, port No., user name, password, channel number, 

start from and manufacturer for the device. 

Note: If you edit 4 in Start From field, it means that the starting channel No. is 4. 
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12.2 Adding the Decoding Device 

Purpose: 

To decode the video of the encoding device and display the decoded video on the Video Wall, the 

decoding device needs to be added to the client. 

Steps: 

1. Click Enter Video Wall Config to enter the decoding device and video wall configuration interface. 

2. In the Decoding Output area, click  to activate the Quick Adding of Decoding Device window. 

 

3. Set the device type as Decoder or Cascading Server.  

Note: To added cascading server here, please enter the Device Management page and click the 

Server tab. Click Add New Device Type, select Cascading Server and click OK. 

For Decoder, there are 2 adding modes available. Select the adding mode and configure the 

corresponding settings for the device. 

For the detailed configuration about the 2 adding modes, please refer to the following sections: 

 By specifying the device IP address or domain, see Section 2.2.3 Adding Devices Manually. 

 By specifying an IP segment, see Section 2.2.4 Adding Devices by IP Segment. 

For Cascading Server, you can add the device via IP address. For detailed configuration, see 

Section 2.2.3 Adding Devices Manually. 

Edit the Output of the Decoding Device 

Steps: 

1. In the Decoding Output area, click  before the decoding device to list the outputs of it.  

2. Double-click an output and you can edit the parameters for it. Or you can right-click a decoding 

output in the video wall area and select Decoding Output Configuration to edit its parameters. 

Note: For HDMI and VGA outputs, the resolution can be configured; for BNC output, the video 

standard can be configured. 

3. (Optional) you can check the checkbox of Batch Configuration and select other outputs to copy 

the settings to. 

4. Click OK to save the settings. 
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12.3 Configuring Video Wall Settings 

Purpose: 

After the encoding device and decoding device have been added, the parameters of Video Wall need 

to be configured for video display. 

12.3.1 Linking Decoding Output with Video Wall 

Steps: 

1. Click Enter Video Wall Config to enter the decoding device and video wall configuration interface. 

2. A default video wall view with the window division of 4*4 is provided. You can edit the default 

video wall or add a new video wall as desired. 

Task 1: Add a Video Wall 

1) Right-click the video wall and select Add Video Wall, or click  to activate the Add Video 

Wall window. 

2) Enter the name, row number, column number and proportion of the video wall. 
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3) Click Add. 

Task 2: Edit a Video Wall 

1) Right-click the video wall and select Modify Video Wall to edit it. 

2) In the pop-up window, you can edit the name, row number, column number and proportion 

of the video wall. 

Note: You can also drag your mouse to set the needed video wall. 

3) Click Modify to save the settings. 

Task 3: Delete a Video Wall 

To delete the video wall, right-click the video wall and select Delete Video Wall, or click  of 

the video wall. 

3. Click-and-drag the decoding output on the left-side list to the display window of video wall, to 

configure the one-to-one correspondence. You can also click and hold the Ctrl or Shift key to 

select multiple outputs and then drag them to the video wall for configuring linkage in batch. You 

can click  in the upper-right corner of the display window to release the linkage. 

Notes: 

 Up to 4 video walls can be added to the client software. 

 The total number of the display windows of the video wall should be no more than 100.  

 The ranges of the row number and column number are both between 1 and 10.   
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12.3.2 Multi-screen Display  

Purpose: 

For DS-6400HDI-T series decoder, you can joint multiple screens as a whole window. In this way, the 

decoded video of one camera can be shown on the jointed window. 

Before you start: 

You should add DS-6400HDI-T series decoding device to the client. Please refer to Section 12.2 Adding 

the Decoding Device for detailed configuration about adding decoding device. 

Steps: 

1. Perform the step 3 of Section 12.3.1 Linking Decoding Output with Video Wall to configure the 

linkage between the decoder and video wall. 

2. Click-and-drag you mouse to select the adjacent display windows for jointing. 

Notes: 

1. You can only joint the same output interfaces as a whole window. E.g., you can only joint 4 

VGA interfaces or HDMI interfaces. 

2. BNC interface does not support jointing. 

 

3. Click  to confirm jointing the screens. 
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4. (Optional) You can set the resolution for the jointed window by right-clicking on it and select 

Decoding Output Configuration. 

To cancel the multi-screen display, click  in the upper-right corner of the display window. 

 

12.3.3 Configuring Background 

Purpose:  

You can upload pictures for showing as the background of the video window. 

Note: The function should be supported by the decoding device. 

Steps: 

1. Click  to expand the Background Picture panel. 

2. Select a background picture and double-click (or right-click and select Background Configuration) 

it to activate the background uploading window. 

  

3. Set a user-defined name for the background picture and click  to select a picture file. 

4. Click Upload to upload the picture. 

5. Click and drag the configured background picture to the desired position of the video wall.  

6. You can move the window when the cursor becomes  and adjust its size when the cursor 

becomes directional arrow. Right-click on the background picture and select Show or Hide to 
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show or hide the background picture. 

Note: The picture will be displayed on the physical video wall after you upload the background.  

 

 

12.3.4 Configuring Virtual LED 

Purpose: 

You can display the required contents on the video wall by using virtual LED. 

Note: The function should be supported by the decoding device. 

Steps: 

1. Click Enter Video Wall Config to enter the configuration interface. 

2. Click   to display the Virtual LED panel, click   to expand the added video wall controller. 

3. Click-and-drag the virtual LED to the video wall. 

4. You can move the window when the cursor becomes   and adjust its size when the cursor 

becomes directional arrow. 

5. Right-click the virtual LED in t he panel and select Virtual LED Settings to set the parameters for 

it. 

 Content: Set the content that you want to display on the video wall. 

 Show Mode: Select the mode of the virtual LED as desired. 

 Moving Mode: Set the scrolling effect for the displayed text. 

 Moving Direction: Set the scrolling direction for the displayed text. 

 Moving Speed: Set the moving speed for the displayed text. 

 Font Size: Set the size of the displayed text. 

 Font Color: Set the color of the displayed text by clicking Color. 

 Background Color: Set the color of the background by clicking Color 
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12.4 Displaying Video on Video Wall 

Purpose: 

After the settings of the encoding device, decoding device and video wall, the video stream from the 

encoding devices can be decoded and displayed on the Video Wall. 

Notes:  

 After enable decoding and displaying, the captured picture of the video from the encoding 

device displays on the Video Wall interface. And the real-time live view is shown on the physical 

video wall. 

 For some kinds of decoder, the video stream from the signal source (which refers to the video 

signal (e.g., PC) connected to the decoder via the local interfaces) can also be displayed on the 

video wall. For detailed configuration, please refer to the User Manual of the device. 

12.4.1 Decoding and Displaying 

Steps: 

1. Click Back to Operation Page to go back to the Video Wall Operation interface. 

2. Click  to save the linkage settings for the current scene. Or click  (beside ) and select a 

scene to save the settings for. 

Notes:  

 Scene settings are only supported by the cascading server. For setting the decoder, please skip 

step 2 and 3. 

 8 scenes can be set for a video wall. Each scene can be configured with different linkage 

settings and window divisions. 

 For editing the name of a scene, select a scene and click  to define a new name for it. You 

can also click  to clear all the settings for the scene. 

3. Select a scene which is configured with linkage settings and click  to enable the scene. 

4. Click-and-drag the camera on the left-side list to the display window of video wall. The video 

stream from the camera will be decoded and displayed on the Video Wall. You can also select a 

decoding window and then double-click a camera to decode and display the video. You can also 

click and hold the Ctrl or Shift key to select multiple cameras and then drag them to the video 

wall. 

Note: For DS-6400HDI-T decoder, you can select the signal source on the Signal Source panel for 

video wall display. 

5. Select a playing window and click the icon  to get a preview of the video in the lower-right 

corner of the screen. Or you can directly drag a camera to the preview window for live view. You 

can also double-click the preview window to get a full-screen view. 

Note: You can move the mouse to the window and click  in the lower-right corner to stop 

decoding. 

6. (Optional) Select a decoding window and click  to set the window division for it. Click  to 

save the settings for the current scene. Or click  (beside ) and select a scene to save the 

settings for. 

7. If the decoded camera supports PTZ control, you can click  beside PTZ to activate the PTZ 
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control panel. For detailed configuration, please refer to Section 2.4.3 PTZ Control in Live View. 

8. Right-click on a playing window to activate the decoding management menu, as shown below: 

Note: The menu differs depending on the devices. 

 
Stop / Start Decoding: Stop / Start the decoding. 

Start / Pause Successive Decoding: Start / Pause the cycle decoding. This function is only supported 

by decoder. 

Refresh: Refresh the decoding. 

Open / Close Digital Zoom: Enable / Disable digital zoom. 

Enable Audio: Turn on / off the audio of the decoding video. 

Enlarge Window: Display the window in full-screen mode. 

Decoding Channel Status: View the status of the decoding channel, such as decoding status, stream 

type. 

Upload Logo: Upload a picture as the logo to the video window and set the display parameters for it. 

After setting, the logo shows in the defined position of the window on physical video wall. 

Show / Hide Logo: Show / Hide the logo. 

Stick on Top: Always stick the window on the top layer. This function is only supported by cascading 

server. 

Stick at Bottom: Always stick the window at the bottom layer. This function is only supported by 

cascading server. 

Lock: Lock the window to disable the roaming function. 

Set Alarm Window: Display the video triggered by event or alarm input on Video Wall. 

Decoding Delay: Set the delay degree of the decoding according to the actual needs. This function is 

only supported by cascading server. 

Go to Playback: Enter the playback mode. This function is only supported by decoder. 
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Icon Description 

 Start all the decoding 

 Stop all the decoding 

 Stop all the roaming windows 

 Refresh all the decoding windows 

 Set cycle decoding and switching interval 

 

12.4.2 Windowing and Roaming Settings 

Purpose: 

Windowing is to open a new window on the screen(s). The window can be within a screen or span 

multiple screens. You can move the playing window within the video wall as desired and this function 

is called roaming. 

Note: The windowing and roaming function should be supported by the decoding device. 

Steps: 

1. Click-and-drag on a screen which links to a decoding output to open a window. The window can 

be within a screen or span multiple screens. If you want to open a window on the opened window, 

click-and-drag and hold the Ctrl key to create one. And for the locked window (refer to step 6), 

you can click-and-drag to create a new window on it. 

Note: At least one camera should be selected before opening window. 

 

2. You can move the window when the cursor becomes  and adjust its size when the cursor 
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becomes directional arrow. You can also hold the Shift key to scale the window in proportion. 

3. During moving the window, the dotted borders will display. The window will be adjusted to align 

with the borders if it is moved to the location near the dotted borders. 

 

4. Double-click the window and it will enlarge to fill the spanning screens and display on the top 

layer. You can double-click again to restore. 

  

5. (Optional) Select a window and click  to set the window division for it. Click  to save the 

settings for it. 

6. Right-click on a window and select Lock in the right-click menu to disable the roaming function, 

and the  icon shows on the top-right corner of the window. In this way, the window cannot be 

moved and resized. You can right-click on the window and select Unlock in the right-click menu to 

recover the roaming function. 

7. Right-click on a window and select Stop Decoding in the right-click menu, or move the mouse to 

the window and click  in the upper-right corner to stop the decoding of the window and it will 

be closed. You can also click  to close all the roaming windows. 

8. The window only shows a captured picture of the decoded video. You can right-click on a window 

and select Refresh in the right-click menu, or move the mouse to the window and click  in the 

lower-right corner to capture a latest picture of the decoded video and display on the window. 

9. If you want to view the specific area of the video in details, you can right-click on a window and 

select Open Digital Zoom (if available) in the right-click menu and the cursor becomes . Use 

the mouse to drag on the video to realize digital zoom. You can check the effect on the physical 

video wall 

10. Select a playing window and click the icon  to get a preview of the video in the lower-right 

corner of the screen. Or you can directly drag a camera to the preview window for live view. You 

can also double-click the preview window to get a full-screen view. 

11. Right-click on a playing window and you can control decoding management via the right-click 

menu. 
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12.4.3 Configuring Playback 

Purpose: 

The record file is supported to be played back on the video wall. 

Note: playback function is only supported by decoder. 

Steps: 

1. Click-and-drag the camera on the left-side list to the display window of video wall, or you can 

open a window if supported. 

2. Move the mouse to the window and click  in the upper-right corner. Or you can right-click on 

the window and select Go to Playback in the right-click menu. 

3. If there is record file of current day, the record file will be played back automatically. If not, you 

can set the search condition on the search panel which shows in the left area of the interface 

(click  to show more search options, and then click the icon  to specify the start time and 

end time for the search), and click Search to find the record file. 

4. Right-click on the playback window and you can control the playback through the right-click menu, 

such as pause, stop, fast forward, slow forward, capture, start recording and full-screen playback. 

Note: The saving path for the captured pictures and recorded files can be configured on System 

Configuration page. Please refer to Section 10.2.3 File Saving Path Settings for detailed settings. 

When you move the mouse to the screen, the icons will display as shown below. 

 

Icon Description 

 Pause the playback 

 Stop the playback 

 Capture the playback video 

 Record the playback video 

 Back to live view mode 

 Playback speed. 

 

12.4.4 Configuring Cycle Decoding 

Purpose: 

The cycle decoding refers that you can configure multiple video streams of encoding devices to one 

decoding output and you can set the switching interval for the decoding. 

Note: The cycle decoding is only supported by decoder. 

Steps: 
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1. Click  beside  and set the switching interval for the cycle decoding. 

2. Click-and-drag the camera on the left-side list to the display window of video wall, or you can 

open a window if supported. 

Note: The cycle decoding is not supported by the signal source of DS-6400HDI-T.  

3. Move the mouse to the group node and click  to start cycle decoding (the decoding output 

under cycle decoding will be marked with ). Right-click on the window and you can control 

decoding management via the right-click menu. 

 

12.5 Configuring Video Wall Controller 

Purpose: 

The client provides the function of managing the added video wall controller. 

12.5.1 Adding the Video Wall Controller 

Purpose: 

You should add the video wall controller to the client for management. 

Steps: 

1. Go to the Device Management page and click the Server tab. 

2. Click Add New Device Type, select Video Wall Controller and click OK. 

3. Select Video Wall Controller in the organization panel and click Add Device to activate the Add 

Device window. 

4. Edit the nickname, IP address / domain name, port No., user name and password for the device. 

5. Click Add to save the settings. 

 

6. For edit the output, please refer to Section 12.2 Adding the Decoding Device. 
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12.5.2 Linking Output with Video Wall 

Steps: 

1. Click Enter Video Wall Config to enter the configuration interface. 

2. A default video wall with the added video wall controller name is provided. You can edit the 

default video wall as desired. For details, please refer to Section 12.3.1 Linking Decoding Output 

with Video Wall. 

3. Click-and-drag the output of the added video wall controller on the left-side list to the display 

window of video wall, to configure the one-to-one correspondence. You can also click and hold 

the Ctrl or Shift key to select multiple outputs and then drag them to the video wall for 

configuring linkage in batch. You can click  in the upper-right corner of the display window to 

release the linkage. 

4. For background settings, please refer to the Section 12.3.3 Configuring Background. 

Notes: 

 The total number of the display windows of the video wall should be no more than 100.  

 The ranges of the row number and column number are both between 1 and 10.   

 

 

12.5.3 Configuring Virtual LED  

Purpose: 

You can display the required contents on the video wall by using virtual LED. 

Steps: 

1. Click Enter Video Wall Config to enter the configuration interface. 

2. Click  to display the Virtual LED panel, click  to expand the added video wall controller. 

3. Click-and-drag the virtual LED to the video wall. 

4. You can move the window when the cursor becomes  and adjust its size when the cursor 

becomes directional arrow. 

5. Right-click the virtual LED in the panel and select Virtual LED Settings to set the parameters for it. 
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 Content: Set the content that you want to display on the video wall. 

 Show Mode: Select the mode of the virtual LED as desired. 

 Moving Mode: Set the scrolling effect for the displayed text. 

 Font Size: Set the size of the displayed text. 

 Font Color: Set the color of the displayed text by clicking Color. 

 Background Color: Set the color of the background by clicking Color 

 

 
 

12.5.4 Configuring Video Wall Screens 

Purpose: 

The screens of the video wall can be configured, including screen type, opening screen, closing 

screen, input source and image parameters. 

Steps: 

1. Click Back to Operation Page to go back to the Video Wall Operation interface. 

2. Click  to activate the Screen Control window. 

3. Click-and-drag on the video wall to select the screens and configure the parameters for 

them. 

Screen Type: Select the type for the selected screens for different screen type adopting 

different communication protocols. 

Open Screen / Close Screen: Open or close the selected screens. 

Open All / Close All: Open or close all the screens. 

Input Source Type: Select the input source for the screen and click Set to save the settings. 

Image Parameters and Position Adjustment: Select brightness or contrast and click  or 

 to adjust the image parameters. Select horizontal or vertical and click  or  to 

adjust the image position on the screen. 
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12.5.5 Displaying Video on Video Wall 

Purpose: 

After adding the video wall controller and linking the output with the video wall, the video stream 

from the encoding devices or the signal source can be displayed on the video wall. 

Notes:  

 Encoding devices refer to the devices connected to iVMS-4200 client via network. 

 Decoding module should be connected to the video wall controller before the video of the 

encoding devices can be decoded and displayed. 

 Signal source refers to the video signal (e.g., analog camera) connected to the video wall 

controller via the local interfaces of the controller. 

 After enable decoding and displaying, the captured picture of the video from the encoding 

device displays on the Video Wall interface. And the real-time live view is shown on the physical 

video wall. 

 For signal source, no captured pictures displaying on the output window. You can check the live 

video on the physical video wall. 

Steps: 

1. Click Back to Operation Page to go back to the Video Wall Operation interface. 

2. Select a scene which is configured with linkage settings and click  to enable the scene. 

3. Click-and-drag the camera or signal source on the left-side list to the display window of video wall. 

The video stream from the camera or signal source will be displayed on the Video Wall. You can 

also select a decoding window and then double-click a camera to decode and display the video. 

You can also click and hold the Ctrl or Shift key to select multiple cameras and then drag them to 

the video wall. 

4. Or you can select a camera or signal source, then click-and-drag on a screen which links to an 

output to open a window. The window can be within a screen or span multiple screens. If you 

want to open a window on the opened window, click-and-drag and hold the Ctrl key to create one. 

For details, please refer to Section 12.4.2 Windowing and Roaming Settings. 

5. Select a playing window and click the icon  to get a preview of the video in the lower-right 

corner of the screen. Or you can directly drag a camera to the preview window for live view. You 
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can also double-click the preview window to get a full-screen view. 

6. Click  to save the current settings as a scene. Or click  (beside ) and select a scene or 

create a new scene to save the settings for. 

Notes:  

 32 scenes can be set for a video wall controller. 

 For editing the name of a scene, select a scene and click  to define a new name for it. You 

can also click  to clear all the settings for the scene. For calling a scene, select a scene and 

click  to enable the scene. 

7. Right-click on a playing window to activate the decoding management menu. 

Note: The menu differs depending on the devices. Please refer to Section 12.4.1 Decoding and 

Displaying for detailed introduction. 

8. For displaying the record files of the encoding device on the video wall, please refer to Section 

12.4.3 Configuring Playback. 

 

12.5.6 Configuring Plan 

Purpose: 

The plan function of video wall controller provides the switching the configured scene(s) and turning 

on or off the screens at a certain time. You can also set the time schedule for switching the operations 

(such as scene, close screens) and the plan can also be auto-switched. 

Before you start: Scene(s) should be added for the video wall controller. Please refer to Section 12.5.5 

Displaying Video on Video Wall for adding scenes. 

Steps: 

1. Click Back to Operation Page to go back to the Video Wall Operation interface. 

2. Click  to display the Plan panel, click Add Plan or right-click on the panel and select Add Plan 

to pop up the Add Plan window. 

Note: Up to 16 plans can be added to a video wall controller. 

 

3. Set the parameters for the plan: 

Nickname: Edit a name for the plan as desired. 

Mode: Select the mode to execute the plan. Manual, Auto and Auto-switch are selectable. 

 Manual: Automatically execute the plan until you stop calling the plan manually. 
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 Auto: Execute the plan according to the configured start time and execution times in 

Parameters panel. 

 Auto-switch: Execute the plan according to the configured time schedule and execution 

times in Parameters panel. 

Plan Task: Set the operations for the plan. The plan will be execute the added operations in 

order. 

 Add: Add an operation for the plan. If you select the Task Type as Display Scene, you can 

select the configured scene in the Scene drop-down list and set the dwell time. If you select 

the Task Type as Open Screen or Close Screen, you can select the screen type for opening or 

closing and set the dwell time. 

 Up: Move the selected operation up. 

 Down: Move the selected operation down. 

 Delete: Remove the selected operation. 

Parameters:  

If you select Auto as the mode, you can set the Start Time and Execution Times. E.g., you set the 

Start Time as 2014-06-04 00:00:00 and Execution Times as 4, then the plan will be executed from 

2014-06-04 00:00:00 and continuously for 4 times before stopping. 

If you select Auto-switch as the mode, you can set the Weekday Settings and Execution Times. 

E.g., you set the Weekday Settings as 10:30:00 of Mon and 08:30:00 of Wed, and Execution 

Times as 6, the plan will be executed from 10:30:00 of Monday and continuously for 6 times, 

then from 08:30:00 of Wednesday and continuously for 6 times. The next week, the plan will be 

executed at the configured time. 

4. Click OK to save the settings. 

5. To call a plan, select a plan and click  to enable the plan. For editing the plan, select a plan and 

click  to edit the settings for it. You can also click  to clear all the settings for the plan. To 

stop the plan, right-click a plan and select Stop Plan. 

Note: Please stop the plan before you want to configure the video wall controller. 
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Chapter 13  Heat Map 

Purpose: 

Heat map is a graphical representation of data represented by colors or the heat map data can be 

displayed in line chart. The heat map function of the camera usually be used to analyze the visit times 

and dwell time of customers in a configured area. 

Before you start: 

Please add a heat map network camera to the software and properly configure the corresponding 

area. The added camera should have been configured with heat map rule. 

Note: The heat map network camera should be added to the software as Encoding Device, please 

refer to Section 2.2 Adding the Device for detailed configuration. For configuring heat map rule, 

please refer to the User Manual of the heat map network camera. 

Click the  icon on the control panel to open the Heat Map page. 

 

Steps: 

1. Open the Heat Map page. 

2. Click to select a heat map camera in the area panel. 

3. Select the report type as needed and set the start time. 

4. Click Generate Heat Map and the heat map of the camera displays. You can click  or  to 

display the statistics in line chart or picture mode. 

In picture mode, the red color block (255, 0, 0) indicates the most welcome area, and blue color 

block (0, 0, 255) indicates the less-popular area. 

5. (Optional) Click  to save the detailed data of heat map to your PC. 
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Chapter 14  People Counting Statistics 

Purpose: 

You can check the people counting statistics of the added people counting device and the statistics 

can be displayed in line chart or histogram. The detailed data can be exported for local storage. 

Before you start: 

Please add a people counting device to the software and properly configure the corresponding area. 

The added device should have been configured with people counting rule. 

Note: The people counting device should be added to the software as Encoding Device, please refer to 

Section 2.2 Adding the Device for detailed configuration. For configuring people counting rule, please 

refer to the User Manual of the people counting device. 

Click the  icon on the control panel to open the People Counting page. 

 

Steps: 

1. Open the People Counting page. 

2. Select the report type as needed and set the time. 

1) Select daily report, weekly report, monthly report or annual report as the time type for the 

report. 

2) Select Multi-camera in One Period, Multi-group in One Period, One Camera in Multi-period, 

or One Group in Multi-period as the statistics type. 

 Multi-camera in One Period: Multiple cameras can be selected for generating the statistics 

for them of one time period. 

 Multi-group in One Period: Multiple groups can be selected for generating the statistics for 

them of one time period. 

 One Camera in Multi-period: One camera can be selected for generating the statistics for it 

of the two time periods. 

 One Group in Multi-period: One group can be selected for generating the statistics for it of 

the two time periods. 

3) Select Enter, Exit, or Enter and Exit as the data type. 



User Manual of iVMS-4200 

131 
 

 Enter: The people entered will be counted. 

 Exit: The people exited will be counted. 

 Enter and Exit: Both people entered and exited will be counted. 

4) Set the time period(s). 

3. Select the camera(s) or group(s) for generating the report. 

4. Click Search and the statistics displays on the right panel. The detailed data for each hour, day or 

month will be also displayed. 

By default, the statistics are shown in histogram form. You can switch it to line chart by clicking 

the . 

5. (Optional) Click  to save the detailed data of people counting to your PC. 
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Chapter 15  Counting Statistics 

Purpose: 

You can check the counting statistics of the added counting device and the statistics can be displayed 

in line chart or histogram. The detailed data can be exported for local storage. 

Before you start: 

Please add a counting device to the software and properly configure the corresponding area. The 

added device should have been configured with counting settings. 

Note: The counting device should be added to the software as Encoding Device, please refer to 

Section 2.2 Adding the Device for detailed configuration. For configuring counting settings, please 

refer to the User Manual of the counting device. 

Click the  icon on the control panel to open the Counting page. 

 

 

Steps: 

 Open the Counting page. 

 Select the report type as needed and set the time. 

1) Select daily report, weekly report, monthly report or annual report as the time type for the 

report. 

2) Select Multi-camera in One Period, Multi-group in One Period, One Camera in Multi-period, 

or One Group in Multi-period as the statistics type. 

 Multi-camera in One Period: Multiple cameras can be selected for generating the statistics 

for them of one time period. 

 Multi-group in One Period: Multiple groups can be selected for generating the statistics for 

them of one time period. 

 One Camera in Multi-period: One camera can be selected for generating the statistics for it 

of the two time periods. 

 One Group in Multi-period: One group can be selected for generating the statistics for it of 

the two time periods. 
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3) Select Enter, Exit, or Enter and Exit as the data type. 

 Enter: The people entered will be counted. 

 Exit: The people exited will be counted. 

 Enter and Exit: Both people entered and exited will be counted. 

4) Set the time period(s). 

 Select the camera(s) or group(s) for generating the report. 

 Click Search and the statistics displays on the right panel. The detailed data for each hour, day or 

month will be also displayed. 

By default, the statistics are shown in histogram form. You can switch it to line chart by clicking 

the . 

 (Optional) Click  to save the detailed data of people counting to your PC. 
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Chapter 16  Road Traffic 

Purpose: 

If you add road traffic monitoring device, the captured pictures of the detected vehicle or license 

plate can be searched and checked. Three types are available for searching the corresponding 

pictures. 

 Vehicle Detection: The passed vehicle can be detected and the picture of its license plate 

can be captured; besides, the vehicle color, vehicle logo and other information can be 

recognized automatically. 

 Mixed-traffic Detection: The pedestrian, motor vehicle and non-motor vehicle can be 

detected, and the picture of the object (for pedestrian / non-motor vehicle / motor vehicle 

without license plate) or license plate (for motor vehicle with license plate) can be searched. 

 Traffic Violations: The captured pictures of the vehicle that violates the traffic rules (such as 

illegal parking and congestion) can be checked. 

Before you start: 

 Please add a road traffic monitoring device to the software and properly configure the 

corresponding area. The added device should have been configured with corresponding settings 

for capturing pictures. 

 For Traffic Violations, the Storage Server should be added to software and you must configure 

the Storage Server for the device and check the checkbox of Picture Storage and Additional 

Information Storage. For details, please refer to Section 3.1.2 Storing on Storage Device. 

 For Vehicle Detection and Mixed-traffic Detection, if no storage server is configured, the 

software will search the related pictures from the storage device of the local device. 

Note: The road traffic monitoring device should be added to the software as Encoding Device, please 

refer to Section 2.2 Adding the Device for detailed configuration. For configuring capture settings, 

please refer to the User Manual of the device. 

Click the  icon on the control panel to open the Road Traffic page. 

 

Steps: 
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1. Open the Road Traffic page. 

2. Click to select a road traffic monitoring camera in the camera panel. 

3. Set the search condition for finding the related pictures. 

Type: Select the query type and the pictures triggered by the event type can be found. 

Plate No.: Input the license plate number for searching the pictures. 

Start Time / End Time: Click  to set the start time and end time. 

4. Click Search and the found picture items will list. 

 

5. Click  to view the captured pictures and the related information. You can check the 

checkbox of Select Current Picture or Select All and click Download to save the pictures to 

your PC. 
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6. (Optional) Check the checkbox(es) to select the picture items and click Export Picture to save 

the pictures to your PC. 
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Chapter 17  VCA Search for Picture 

Purpose: 

When the connected device (NVR or HDVR) supports face, behavior and license plate search, you can 

search the related picture and play the picture related video file. 

Before you start: 

Please add the device to the software and properly configure the corresponding settings. For detailed 

settings, please refer to the User Manual of the device. 

Note: The device should be added to the software as Encoding Device, please refer to Section 2.2 

Adding the Device for detailed configuration.  

Click the  icon on the control panel to open the VCA Search for Picture page. 

 

Steps: 

1. Open the VCA Search for Picture page. 

2. Click By Face, By Behavior Analysis or By License Plate Number tab to enter the related page. 

3. Click to select a device in the camera panel. 

Note: This function should be supported by the connected device (NVR or HDVR). 

4. Set the corresponding search condition. 

Face:  

1) (Optional) You can check the checkbox of By Picture, click Select Picture to upload the 

pictures from your PC and click to select a detected face from uploaded picture for 

matching the captured face pictures. Set the similarity level. 

Example: If you set the similarity as 40, the captured pictures have no less than 40% 

similarity with the uploaded face picture will list. 

2) Click  to set the start time and end time for searching the captured face pictures or 

video files. 

Behavior Analysis: Click  to set the start time and end time for searching the matched 

pictures. 

License Plate Number:  
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1) (Optional) Input the license plate number in the field for search. 

2) Click  to set the start time and end time for searching the matched license plate 

pictures. 

5. Click Search to start searching. The search results of the pictures are displayed in list. 

 

6. You can click on a picture from the list to check the detailed information and click  to play its 

related video file in the view window on the bottom right.  

You can click  to adjust the play speed of the playback, click  to play back the record files 

frame by frame, click  to double-click the playback window to maximize the window.  
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Chapter 18  Web Browsing 

Purpose: 

The iVMS-4200 client software can also be accessed through web browsing. It provides the 

functionalities of live view, playback, device management, account management, system configuration, 

etc. 

18.1 Login 

Steps: 

1. Input the IP address of the PC running the iVMS-4200 in the address bar of the web browser, and 

press the Enter key. A login window will pop up. 

2. Input the user name and password of iVMS-4200. 

3. Optionally, check the checkbox Remember password to save the password. 

4. Click Login. 

Note: You can set the language as Chinese or English in the upper-right corner of the login interface. 

 

 

The homepage of the web browser after you login is shown as below. 
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18.2 Device Management 

Purpose: 

Before doing any operations via the web browser, devices need to be added to the system for 

monitoring and management. You can add devices through the web browser. 

Adding the Encoding Device 

Steps: 

1. Click the Device Management tab to open the Device Management page. 

2. Click the Server tab. 

3. Click Encoding Device to enter Encoding Device Adding interface. 

 

 

You can add the encoding device in the following ways: 

 Adding Devices Manually. 

 Adding Devices by IP Segment. 

 Adding Devices by IP Server. 

 Adding Devices by HiDDNS. 

 

Adding Devices Manually 

Steps: 

1. Click the  icon to open the device adding dialog box. 

2. Select IP/Domain as the adding mode from the drop-down list. 

3. Input the required information. 

Nickname: Edit a name for the device as you want. 

Address: Input the device’s IP address or domain name. 

Port: Input the device port number. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product. And we 

recommend you reset your password regularly, especially in the high security system, 

resetting the password monthly or weekly can better protect your product. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All 
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the channels of the device will be imported to the corresponding group by default. 

5. Click OK to add the device. 

 

 

Adding Devices by IP Segment 

Steps: 

1. Click the  icon to open the device adding dialog box. 

2. Select IP Segment as the adding mode from the drop-down list. 

3. Input the required information.  

Start IP: Input a start IP address. 

End IP: Input an end IP address in the same network segment with the start IP. 

Port: Input the device port number. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product. And we 

recommend you reset your password regularly, especially in the high security system, 

resetting the password monthly or weekly can better protect your product. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device IP. All the 

channels of the device will be imported to the corresponding group by default. 

5. Click OK, and the device of which the IP address is between the start IP and end IP will be added 

to the device list.  
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Adding Devices by IP Server 

Steps: 

1. Click the  icon to open the device adding dialog box. 

2. Select IP Server as the adding mode from the drop-down list. 

3. Input the required information. 

Nickname: Edit a name for the device as you want. 

Server Address: Input the IP Server address. 

Device ID: Input the device ID registered on the IP server. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password.  

 

For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product. And we 

recommend you reset your password regularly, especially in the high security system, 

resetting the password monthly or weekly can better protect your product. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All 

the channels of the device will be imported to the corresponding group by default. 

5. Click OK to add the device. 
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Adding Devices by HiDDNS 

Steps: 

1. Click the  icon to open the device adding dialog box. 

2. Select HiDDNS as the adding mode from the drop-down list. 

3. Input the required information. 

Nickname: Edit a name for the device as you want. 

Server Address: www.hik-online.com. 

Device Domain Name: Input the device domain name registered on the HiDDNS server. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. 

 

For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product. And we 

recommend you reset your password regularly, especially in the high security system, 

resetting the password monthly or weekly can better protect your product. 

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All 

the channels of the device will be imported to the corresponding group by default. 

5. Click OK to add the device. 

http://www.hik-online.com/
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Note: Check the checkbox Add Offline Device, input the required information and the device channel 

count, and then click Add. When the offline device comes online, the software will connect it 

automatically. 

 

The devices will be displayed on the device list for management after added successfully. You can 

check the nickname, IP address, serial No., HDD status, recording status and other information of the 

added devices on the list. 

Click Refresh All to refresh the information of all added devices. You can also input the device name in 

the filter field for search. 

Select device from the list, click Modify/Delete, and then you can modify/delete the information of 

the selected device. 

Select device from the list, click Remote Config, and then you can do some remote configurations of 

the selected device if needed. 

Importing Devices to Groups 

Purpose: 

After the devices added successfully, you can import the devices into groups for a convenient 

management. 

Steps: 

1. Open the Device Management page. 

2. Click the Group tab to enter the Group Management interface. 

3. Click Add Group to open the Add Group dialog box. 

4. Input the group name and click OK to create a new group. 

5. Click Import to enter the Import Device interface. 

6. Select the encoding channels from the device list and then select a group from the group list. 

7. Click Import Select to import the selected encoding channels to the group. 

You can also click Import All to import all the encoding channels to a selected group. 
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Click Add, and you can add a new group to the group list. 

Click Modify after selecting a group/camera, and you can modify the group/camera information. 

Click Delete after selecting a group/camera, and you can remove all cameras/the selected camera 

from the group. 

To delete a group, select the group from the list on the Group Management interface and click the 

Delete Group button  

18.3 Live View 

Purpose: 

On the Live View page, you can view the live video of the added cameras and do some basic 

operations, including picture capturing, recording, PTZ control, etc. 

Before you start: 

A camera group is required to be defined for live view. 

 

Click the Live View tab to open the Live View page. 
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Starting Live View 

Steps: 

1. Open the Live View page. 

2. Optionally, click the  icon in the live view toolbar, and select the screen layout mode. 

3. Click-and-drag the camera to the display window, 

or double-click the camera name after selecting the display window to start the live view. 

 

 

Live View Toolbar: 

 
On the Live View page, the following toolbar buttons are available: 

 Set View 
Set the screen layout mode. 4 types of screen layout modes are 

selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen. 

  Stop/Start Live View Stop/Start the live view of all cameras. 

 Capture Capture the picture in the live view process. 

  Start/Stop Recording Start/Stop the manual recording. The record file is stored in the PC. 

 Previous Go for live view of the previous page. 

 Next Go for live view of the next page. 

  Mute/Audio On Turn off/on the audio in live view 

  Digital Zoom Enable/Disable the digital zoom function. 

 Full Screen Display the live view in full screen mode. Press ESC to exit. 

 

PTZ Control Functionality 

Purpose: 

Cameras with the pan/tilt/zoom functionality can be controlled through the web browser. You can also 

set the preset, patrol and pattern for the cameras. 

Click the  icon to expand the PTZ Control panel on the Live View page. 
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Configuring the Preset 

Perform the following steps to add a preset: 

1. Click the Preset button to enter the PTZ preset configuration panel. 

2. Click the direction buttons to steer the camera to the desired view. 

3. Select a PTZ preset number from the preset list and click the icon . 

 

To call a configured preset, select the preset from the list and click the icon . 

To delete a configured preset, select the preset from the list and click the icon . 

 

 

Configuring the Pattern 

1. Click the Pattern button to enter the PTZ pattern configuration panel. 

2. Click  to start recording of this pattern path. 

3. Use the direction buttons to control the PTZ movement. 

4. Click  to stop and save the pattern recording.  

5. Click the icon  to call the pattern. To stop calling the pattern, click . 

Note: Only one pattern can be configured, and the newly-defined pattern will overwrite the previous 
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pattern. 

 

 

Configuring the Patrol 

Before you start: 

Two or more presets for one camera need to be added. 

Perform the following steps to add and call a patrol: 

1. Click the Patrol button to enter the PTZ patrol configuration panel. 

2. Select a track number from the drop-down list. 

3. Click  to add a preset, and set the dwell time and patrol speed for the preset. 

4. Repeat the above operation to add other presets to the patrol. 

5. Optionally, you can click  or  to edit or delete the preset in the patrol path. 

6. Click the icon  to call the patrol. To stop calling the patrol, click . 

Notes: 

 Up to 16 patrols can be configured. 

 The preset dwell time can be set to 1~255 sec, and the patrol speed can be set to level 1~40. 
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Video Settings Functionality 

Purpose: 

The video parameters, including the brightness, contrast, saturation and hue, can be configured to 

create better visual effects. 

Steps: 

1. Click the  icon to expand the Video Settings panel on the Live View page. 

2. Move the slider to adjust the brightness, contrast, saturation or hue of the live video. 

3. Click Default Value, and you can restore the defaults of the video parameters. 

 

 

18.4 Playback 

Purpose: 

The record files stored on the storage devices such as the HDDs, Net HDDs and SD/SDHC cards on the 

local device can be searched and played back remotely through the web browser. 

 

Click the Playback tab to open the Playback page. 

 

 

Playback Toolbar: 

 
On the Playback page, the following toolbar buttons are available: 

 Set View Set the screen layout mode. 4 types of screen layout modes are 
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selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen. 

  Stop/Start Playback Stop/Start the playback of all channels. 

 Capture Capture the picture in the playback process. 

  Start/Stop Clipping Start/Stop clipping the record files. 

  Mute/Audio On Turn off/on the audio in playback. 

 Full Screen Display the playback in full screen mode. Press ESC to exit. 

 

Searching Record Files 

Steps: 

1. Open the Playback page. 

2. Select the cameras to be searched from the list. 

3. Click the icon  to specify the start time and end time for the search. 

4. Click Search. The record files of the selected cameras will be displayed on the Search Result tab 

page. 

Notes:  

 You can also search the record files by the card number (only applicable to ATM DVR) or by the 

file type. 

 Up to 16 cameras can be searched simultaneously. 

 

 

Playing Back Record Files 

After searching the record files, you can play back the record files in the following two ways: 

 Playback by File List 

Select the record file from the search result list, and then click the icon  to play the video on 

the display window of playback. 
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 Playback by Timeline 

The timeline indicates the time duration for the record file. Click on the timeline to play back the 

video of the specific time. 

You can click  or  to scale up or scale down the timeline bar. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 

 

 

Move the mouse pointer to the display window in playback to show the toolbar. 

Toolbar in Each Playback Display Window: 

 
 

In each playback display window, the following toolbar buttons are available: 

  Pause/Start Playback Pause/Start the playback of the record files. 

 Stop Playback Stop the playback of all cameras. 

 Slow Forward Decrease the playback speed of the record files. 

 Fast Forward Increase the playback speed of the record files. 

 Single Frame Play back the record files frame by frame. 

 Download Download the record file for backup. 
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18.5 Account Management 

Purpose: 

Different user accounts can be added for the client through the web browser and you can also assign 

permissions for the added users. The user you registered is set as the super administrator. 

 

Click the Account Management tab to open the Account Management page. 

 

 

Adding the User 

Steps: 

1. Open the Account Management page. 

2. Click Add to open the Add User dialog box. 

3. Select the user type. You can set the user type as Administrator or Operator.  

4. Input the user name, password and confirm password as desired. 

5. Check the checkboxes to assign the permissions for the created user. 

6. Optionally, you can click Default Permission to restore the default permissions of this user. 

7. Click Save to save the settings. 

 

 A user name cannot contain any of the following characters: / \ : * ? “ < > |. And the length of 

the password cannot be less than 6 characters. 

 For your privacy, we strongly recommend changing the password to something of your own 

choosing (using a minimum of 8 characters, including upper case letters, lower case letters, 

numbers, and special characters) in order to increase the security of your product.  

 Proper configuration of all passwords and other security settings is the responsibility of the 

installer and/or end-user. 

Note: Up to 50 user accounts can be added for the client software. 
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Managing the User 

Purpose: 

The newly created user account is added to the user list. You can edit or delete the information of the 

user accounts. 

To edit the information of the user, select the user from the user list, and click Modify. 

To delete the information of the user, select the user from the user list, and click Delete. 

18.6 System Configuration 

Purpose: 

The general parameters, including network performance, play performance and saving paths of files 

can be configured through the web browser. 

 

Click the System Configuration tab to open the System Configuration page. 

 

 

Steps: 

1. Open the System Configuration page. 

2. Set the network performance and play performance. Click the icon  to select a local saving 

path for the files. For details, see Table 10.1 System Parameters. 
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3. Optionally, you can click Default Value to restore the defaults of all system parameters. 

4. Click Save to save the settings. 

Table 10.1 System Parameters 

Parameters Descriptions 

Network Performance The current network conditions. It can be set as Normal, Better or Best. 

Play Performance 
The play performance of the live video. It can be set as Shortest Delay, Real 

Time, Balanced or Fluency. 

Saving Path of Video 

Files 

The saving path of video files recorded by manual recording. 

Saving Path of Pictures The saving path of the captured pictures in live view or playback. 

Saving Path of 

Configuration File 

The saving path of the system configuration files. 
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Troubleshooting 

Live View 

Problem: 

 Failed to get the live view of a certain device. 

Possible Reasons: 

 Unstable network or the network performance is not good enough. 

 The device is offline. 

 Too many accesses to the remote device cause the load of the device too high. 

 The current user has no permission for live view. 

 The version of the client software is below the needed version. 

Solutions: 

 Check network status and disable other not in use process on your PC. 

 Check the device network status. 

 Restart the device or disable other remote access to the device. 

 Log in with the admin user and try again. 

 Download the client software of the latest version. 

Recording 

Problem: 

 Local recording and remote recording are confused. 

Solutions:  

 The local recording in this manual refers to the recording which stores the record files on the 

HDDs, SD/SDHC cards of the local device. 

 The remote recording refers to the recording action commanded by the client on the remote 

device side. 

Playback 

Problem: 

 Failed to download the record files or the downloading speed is too slow. 

Possible Reasons: 

 Unstable network or the network performance is not good enough. 

 The NIC type is not compatible. 

 Too many accesses to the remote device 

 The current user has no permission for playback. 

 The version of the client software is below the needed version. 

Solutions: 

 Check network status and disable other not in use process on your PC. 

 Directly connect the PC running the client to device to check the compatibility of the NIC card. 

 Restart the device or disable other remote access to the device. 

 Log in with the admin user and try again. 

 Download the client software of the latest version. 

0203011050415 
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